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Product comparison

Base models
[ J
[}
[ J

Prints up to 20 pages per minute (ppm) on letter-size and A4-size media.

100-sheet multipurpose tray (Tray 1) and 250-sheet input tray (Tray 2)
Optional 500-sheet input tray (Tray 3)
Hi-Speed universal serial bus (USB) 2.0 port

Network models

Prints up to 20 ppm on letter-size and A4-size media.

100-sheet multipurpose tray (Tray 1) and 250-sheet input tray (Tray 2)
Optional 500-sheet input tray (Tray 3)

Hi-Speed universal serial bus (USB) 2.0 port

Built-in 10/100 Base-T network port with IPv4/IPv6

Duplex models

Prints up to 10 ppm on letter-size and A4-size media.

100-sheet multipurpose tray (Tray 1) and 250-sheet input tray (Tray 2)
Optional 500-sheet input tray (Tray 3)

Hi-Speed universal serial bus (USB) 2.0 port

Built-in 10/100 Base-T network port with IPv4/IPv6

Automatic duplexer

Chapter 1 Product basics
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Environmental features

ENWW

Duplex

Save paper by using duplex printing as your default print setting.

Recycling

Reduce waste by using recycled paper.

Recycle print cartridges by using the HP Planet Partners return process. See HP LaserJet print
supplies on page 141.

For more information about recycling, go to www.hp.com/recycle.

Energy savings

Save energy by initiating sleep mode for the product.

HP Smart Web printing

Use HP Smart Web printing to select, store, and organize text and graphics from multiple Web
pages and then edit and print exactly what you see onscreen. It gives you the control you need
for printing meaningful information while minimizing waste.

Job storage

Use the job storage features to manage print jobs. By using job storage, you activate printing
while you are at the shared product, eliminating lost print jobs that are then reprinted.

Environmental features

3
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Product features

Print

Prints up to 20 pages per minute (ppm) on letter-size and A4-size media.

Prints at 600 x 600 dots per inch (dpi) with Image REt 3600 text and graphics.

Includes adjustable settings to optimize print quality.

Offers automatic duplexing (duplex models only).

Memory

Includes 192-megabyte (MB) random-access memory (RAM).

Supported operating
systems

Windows Vista (Starter Edition, 32-bit, and 64-bit)
Windows Vista Server 2008 (32-bit)

Windows XP (32-bit, Service Pack 2)

Windows XP (64-bit, Service Pack 1)

Windows Server 2003 (Service Pack 1)

Windows 2000 (Service Pack 4)

Mac OS X v10.3, v10.4, v10.5, and v10.6

Paper handling

Tray 1 (multipurpose tray) holds up to 100 sheets of print media or 10 envelopes.

Tray 2 holds up to 250 sheets of print media.
Optional Tray 3 holds up to 500 sheets of print media.

Output bin holds up to 250 sheets of print media.

Printer driver features

ImageREt 3600 has been improved for this product. The improvements offer trapping
technologies, greater control over dot placement, and more precise control of toner
distribution within a dot. These new technologies result in high quality printing with smooth

colors.

Interface connections

Includes a Hi-Speed USB 2.0 port.

Built-in 10/100 Base-T network port with IPv4/IPv6 (network models only).

Environmental features

To determine the Energy Star® qualification status for this product, see the Product Data

Sheet or Specifications Sheet.

Economical printing

Provides N-up printing (printing more than one page on a sheet).

The printer driver provides the option to manually print on both sides.

Supplies The print cartridges use HP ColorSphere toner. For information about the number of pages
the cartridges can print, see www.hp.com/go/pageyield. Actual yield depends on specific
use.

Accessibility Online user guide is compatible with text screen-readers.

Print cartridges can be installed and removed by using one hand.

All doors and covers can be opened by using one hand.

4 Chapter 1 Product basics
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Product views

Front and side view

ENWW

Output bin (holds 250 sheets of standard paper)

Front door (provides access to the print cartridges)

Tray 2 (holds 250 sheets of standard paper and provides jam access)

Optional Tray 3 (holds 500 sheets of standard paper)

Power button

Control panel

Optional Tray 3 right jam access

Tray 1 (multipurpose tray—holds 100 sheets of standard paper)

Product views
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Back view

1 Rear door (for toner waste bin access)

2 DIMM door (for adding memory—one additional DIMM slot is available)

3 Hi-Speed USB 2.0 port and network port (network models only)

4 Power connection

Model and serial numbers
The model number and serial number are listed on an identification label located on the left side of the

product.

The label contains information about the country/region of origin and the revision level, manufacturing
date, production code, and production number of the product. The label also contains power rating and

regulatory information.

—
—
—
—=
—
—
=
—
—
=
=
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° Control-panel layout

° Control-panel menus
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Control-panel layout

The product has the following items on the control panel.

o

chA
20
\ %)

—@
—

Control-panel display: The display provides information about the product. Use the menus on the display to establish
product settings.

Back arrow button +: Use this button for the following actions:
o  Exit the control-panel menus.
e  Scroll back to a previous menu in a submenu list.

e  Scroll back to a previous menu item in a submenu list (without saving changes to the menu item).

Left arrow button «: Use this button to navigate through the menus or to decrease a value that appears on the display.

OK button: Press the OK button for the following actions:

e  Open the control-panel menus.

e  Open a submenu displayed on the control-panel display.
o  Select a menu item.

o  Clear some errors.

e Begin a print job in response to a control-panel prompt (for example, when the message [OK] to print appears on
the control-panel display).

Right arrow button »: Use this button to navigate through the menus or to increase a value that appears on the display.

Cancel button (%): Press this button to cancel a print job whenever the attention light is blinking or to exit the control-panel
menus.

Ready light (green): The Ready light is on when the product is ready to print. It blinks when the product is receiving print
data.

Attention light (amber): The Attention light blinks when the product requires user attention.

Chapter 2 Control panel ENWW



Control-panel menus

Use the menus

1.
2,

4,
5.

Press the OK button to open the menus.
Press the left arrow « or right arrow » button to navigate through the listings.

Press the OK button to select the appropriate option. An asterisk (*) appears next to the active
selection.

Press the back arrow % to scroll back through the submenus.

Press the cancel button (%) to exit the menu without saving any changes.

The sections that follow describe the options for each of the main menus:

Reports menu on page 9

System Setup menu on page 11

Network Configuration menu on page 15

Service menu on page 14

Reports menu

ENWW

Use the Reports menu to print reports that provide information about the product.

Menu item Description

Demo Page Prints a color page that demonstrates print quality.

Menu Structure Prints a map of the control-panel-menu layout.

Configuration Report Prints a list of all the product settings. Includes network information when the product is

connected to a network.

Supplies Status Prints the status for each print cartridge, including the following information:

e Approximate pages remaining
e Approximate percentage of cartridge life remaining for each color
e  Part number

e  Approximate number of pages printed

Network Summary Prints a list of all product network settings (network models only).

Usage Page Prints a page that lists PCL pages, PCL 6 pages, HP postscript level 3 emulation pages,

pages that were jammed or mispicked in the product, monochrome (black and white) or color
pages; and reports the page count.

PCL Font List Prints a list of all the PCL fonts that are installed.

PS Font List Prints a list of all the PostScript (PS) fonts that are installed.

PCL 6 Font List Prints a list of all the PCL6 fonts that are installed.

Color Usage Log Prints a report that shows the user name, application name, and color usage information on

a job-by-job basis.

Control-panel menus 9



Menu item Description

Service Page Prints the service report.

Diagnostics Page Prints the calibration and color diagnostics pages.

10 Chapter 2 Control panel ENWW



System Setup menu

Use this menu to establish basic product settings. The System Setup menu has several sub-menus.

Each is described in the following table.

Menu item Sub-menu item Sub-menu item Description
Language Select the language for the control-panel
display messages and the product
reports.
Paper Setup Default Paper Size Letter Select the size for printing internal reports
or any print job that does not specify a
A4 size.
Legal
A3
11x17

Default Paper Type

A list of available media
types appears.

Select the media type for printing internal
reports or any print job that does not

specify a type.

Tray 1

Paper Size

Paper Type

Select the default size and type for Tray 1
from the list of available sizes and types.

Tray 2

Paper Size

Paper Type

Select the default size and type for Tray 2
from the list of available sizes and types.

Tray 3

Paper Size

Paper Type

If optional Tray 3 is installed, select the
default size and type for Tray 3 from the
list of available sizes and types.

Paper Out Action

Wait Forever

Override

Cancel

Select how the product should react
when a print job requires a size or type
that is not available or when a specified
tray is empty.

Select the Wait Forever option to make
the product wait until you load the correct
media, and then press the OK button.
This is the default setting.

Select the Override option to print on a
different size or type after a specified
delay.

Select the Cancel option to automatically
cancel the print job after a specified
delay.

If you select either the Override or
Cancel option, the control panel prompts
you to specify the number of seconds to
delay. Use the arrow buttons to increase
or decrease the time.

ENWW
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Menu item Sub-menu item Sub-menu item Description
Print Quality Allow Color Printing Yes Select the Yes option to allow the job to
print in monochrome (black and white) or
No color depending on the job. This is the

default setting.

Select the No option to disable color
printing. All jobs will print in monochrome
(black and white). Some internal pages
will still print in color.

Color Calibration

Calibrate Now

Power-On Calibration

Calibrate Now: Makes the product
perform a calibration immediately. If a job
is processing, the product calibrates after
the job is complete. If an error message
is displayed, you must clear the error first.

Power-On Calibration: Select how soon
the product should calibrate after you turn
it on. The default setting is the 15
minutes option.

Adjust Alignment

Print Test Page

Adjust Tray <X>

Print Test Page: Print a test page that
tests product print alignment.

Adjust Tray <X>: Adjust the alignment of
the specified tray.

PowerSave Time

Sleep Delay Off Sets how long the product remains idle
before it enters PowerSave mode. The
1 minute product automatically exits PowerSave
mode when you send a print job or press
15 minutes a control-panel button.
30 minutes The default setting is the 15 minutes
option.
1 hour
2 hours
Auto-Off Delay Never Select one of the time-period options to
set the amount of inactive time the
1 hour product will wait before shutting off as a
way to conserve energy.
2 hours
Select the Never option to prevent the
4 hours product from shutting off after a given
amount of time. This is the default setting.
8 hours
24 hours
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Menu item

Sub-menu item

Sub-menu item

Description

At Very Low

Black Cartridge

Stop
Prompt

Continue

Stop: If the product determines that the
black cartridge has reached the
estimated end of life, it stops printing. The
supply may still be able to produce
acceptable print quality. To continue
printing, either replace the supply or
reconfigure the product settings.

Prompt: If the product determines that
the black cartridge has reached the
estimated end of life, select this setting to
be prompted at the control panel to
continue printing. The supply does not
need to be replaced unless the print
quality is no longer acceptable. Once an
HP supply has reached estimated end of
life, HP’s premium Protection Warranty
on that supply has ended. This is the
default setting.

Continue: If the product determines that
the black cartridge has reached the
estimated end of life, select this setting to
continue printing until there is a decrease
in print quality.

At Very Low

Color Cartridge

Stop
Prompt
Continue

Print Black

Stop: If the product determines that a
cartridge has reached the estimated end
of life, it stops printing. The supply may
still be able to produce acceptable print
quality. To continue printing, either
replace the supply or reconfigure the
product settings.

Prompt: If the product determines that a
color print cartridge has reached the
estimated end of life, select this setting to
be prompted at the control panel to
continue printing. The supply does not
need to be replaced unless the print
quality is no longer acceptable. Once an
HP supply has reached estimated end of
life, HP’s premium Protection Warranty
on that supply has ended. This is the
default setting.

Continue: If the product determines that
a color print cartridge has reached the
estimated end of life, select this setting to
continue printing until there is a decrease
in print quality.

Print Black: If the product determines
that a color print cartridge has reached
the estimated end of life, select this
setting to continue printing using black
only.

Control-panel menus
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Menu item Sub-menu item Sub-menu item Description
User-Defined Low Black The user-defined percentage threshold
determines when the product begins
Cyan reporting that the cartridge life is low. The
message appears on the control-panel
Magenta display.
Yellow
Courier Font Regular Select a version of the Courier font.
Dark The Dark option is an internal Courier

font available on HP LaserJet Series IlI
printers and older.

Service menu

Use this menu to restore default settings, clean the product, and activate special modes that affect print

output.

Menu item

Sub-menu item

Description

Cleaning Page

Use this option to clean the product if you see toner specks or
other marks on the printed output. The cleaning process
removes dust and excess toner from the paper path.

When you select this item, the product prompts you to load
plain paper in Tray 1 and then press the OK button to start the
cleaning process. Wait until the process is complete. Discard
the page that prints.

Cleaning Mode

Use this option to clean the bottom side of the scanner glass.

USB Speed High Sets the USB speed to High or Full. For the product to actually
operate at high speed, it must have high speed enabled and
Full be connected to an EHCI host controller that is also operating
at high speed. This menu item also does not reflect the current
operating speed of the product.
The default setting is High.
Less Paper Curl Off If printed pages are consistently curled, use this option to set
the product to a mode that reduces curl.
On
The default setting is Off.
Archive Print Off If you are printing pages that will be stored for a long time, use
this option to set the product to a mode that reduces toner
On smearing and dusting.
The default setting is Off.
Restore Defaults Yes Sets all customized settings to the factory default values.
No

14 Chapter 2 Control panel

ENWW



Network Configuration menu

Use this menu to establish network configuration settings.

Bf NOTE: This menu appears on network models only.

Menu item Sub-menu item Description
TCPI/IP Configuration Automatic Select the Automatic option to automatically
configure all the TCP/IP settings.
Manual
Select the Manual option to manually configure the
IP address, subnet mask, and default gateway.
The default setting is Automatic.
Auto Crossover On This item is used when you are connecting the
product directly to a personal computer using an
Off Ethernet cable (you might have to set this to On or
Off depending on the computer being used).
The default setting is the On option.
Network Services IPv4 This item is used by the network administrator to limit
the network services available on this product.
IPv6
On
Off
The default setting for all items is On.
Show IP address No No: The product IP address will not appear on the
control-panel display.
Yes
Yes: The product IP address will appear on the
control-panel display, alternating between supplies
information and the product IP address. The IP
address will not be displayed if an error condition
exits.
The default setting is No.
Link Speed Automatic (default) Sets the link speed manually if needed.
10T Full After setting the link speed, the product automatically
restarts.
10T Half
100TX Full
100TX Half
Restore Defaults Press the OK button to restore the network

configuration settings to the default values.

ENWW Control-panel menus 15
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° Install the Windows software

e  Supported utilities
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Supported operating systems for Windows
The product supports the following Windows operating systems:
o  Windows Vista (Starter Edition, 32-bit, and 64-bit)
e Windows Vista Server 2008 (32-bit)
e  Windows XP (32-bit, Service Pack 2)
e Windows XP (64-bit, Service Pack 1)
e  Windows Server 2003 (Service Pack 1)
e  Windows 2000 (Service Pack 4)

Supported printer drivers for Windows
e PCL 6 (on the software CD)
e PCL 5 universal printer driver (HP UPD) (available on the Web)
e  HP postscript level 3 emulation universal printer driver (available on the Web)

The printer drivers include online Help that has instructions for common printing tasks and also describes
the buttons, checkboxes, and drop-down lists that are in the printer driver.

Ef NOTE: The PCL 5 and HP postscript level 3 emulation universal printer drivers that support this
product are versions of the HP Universal Print Driver (UPD) for Windows. They install and operate in
the same manner as previous versions of those drivers, and they do not require any special
configuration. For more information about the UPDs, see www.hp.com/go/upd.

HP Universal Print Driver (UPD)

The HP Universal Print Drivers (UPDs) for Windows are drivers that give you instant access to virtually
any HP LaserJet product, from any location, without downloading separate drivers. They are built on
proven HP print driver technology and have been tested thoroughly and used with many software
programs. They are powerful solutions that perform consistently over time. For this product, there are
two UPDs available:

e PCL5UPD
e  HP postscript level 3 emulation UPD

An HP UPD communicates directly with each HP product, gathers configuration information, and then
customizes the user interface to show the product’s unique, available features. It automatically enables
features that are available for the product, such as two-sided printing and stapling, so you do not need
to enable them manually.

For more information, go to www.hp.com/go/upd.
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Priority for print settings

Changes to print settings are prioritized depending on where the changes are made:

= NOTE: The names of commands and dialog boxes might vary depending on your software program.

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Windows

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

ENWW

1. On the File menu in the software
program, click Print.

2. Select the driver, and then click
Properties or Preferences.

The steps can vary; this procedure is
most common.

1.

Windows XP, Windows Server
2003, and Windows Server 2008
(using the default Start menu
view): Click Start, and then click
Printers and Faxes.

-0r-

Windows 2000, Windows XP,
Windows Server 2003, and
Windows Server 2008 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

=-Or=-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

1.

Windows XP, Windows Server
2003, and Windows Server 2008
(using the default Start menu
view): Click Start, and then click
Printers and Faxes.

-0r-

Windows 2000, Windows XP,
Windows Server 2003, and
Windows Server 2008 (using the
Classic Start menu view): Click
Start, click Settings, and then click
Printers.

=-Or-

Windows Vista: Click Start, click
Control Panel, and then in the
category for Hardware and
Sound click Printer.

2. Right-click the driver icon, and then 2.  Right-click the driver icon, and then
select Printing Preferences. select Properties.
3. Click the Device Settings tab.

Priority for print settings 19



Install the Windows software

Software installation types for Windows

The software installer instructs you when to connect the product to a computer or a network. After the
product is connected, the installer gives you the option of finishing the installation without installing all
recommended software.

The following operating systems support the “full” installation of recommended software.
e  Windows Vista 32-bit

e  Windows Vista 64-bit

e  Windows XP, Service Pack 2

The following operating systems support the “minimal” installation, which does not include the
recommended software.

e Windows Vista Starter Edition

e Windows Vista 32-bit

e Windows Vista 64-bit

e  Windows Vista Server 2008, 32 bit

e Windows XP, Service Pack 2

e  Windows XP 64-bit, Service Pack 1

e  Windows Server 2003, Service Pack 1

e Windows 2000, Service Pack 4

Remove software for Windows
1. Click Start, and then click All Programs.
2. Click HP, and then click HP Color LaserJet CP5220 Series printer.

3. Click Uninstall, and then follow the onscreen instructions to remove the software.
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HP Web Jetadmin is a browser-based management tool for HP Jetdirect-connected printers within your
intranet, and it should be installed only on the network administrator’'s computer.

To download a current version of HP Web Jetadmin and for the latest list of supported host systems,
visit

When installed on a host server, a Windows client can gain access to HP Web Jetadmin by using a
supported Java-enabled Web browser (such as Microsoft Internet Explorer or Netscape Navigator) by
navigating to the HP Web Jetadmin host.

The product is equipped with an embedded Web server, which provides access to information about
the network-connected product and network activities. This information appears in a Web browser, such
as Microsoft Internet Explorer, Netscape Navigator, Apple Safari, or Firefox.

The embedded Web server resides on the product. It is not loaded on a network server.

The embedded Web server provides an interface to the product that anyone who has a network-
connected computer and a standard Web browser can use. No special software is installed or
configured, but you must have a supported Web browser on your computer. To gain access to the
embedded Web server, type the IP address for the product in the address line of the browser. (To find
the IP address, print a configuration page. For more information about printing a configuration page,
see J)

For a complete explanation of the features and functionality of the embedded Web server, see

Supported utilities
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HP ToolboxFX

HP ToolboxFX software is a program that you can use for the following tasks:
e  Check the product status

e  Check the supplies status and shop online for supplies

e  Setup alerts

e View product usage reports

e View product documentation

e Gain access to troubleshooting and maintenance tools

HP ToolboxFX is supported for direct USB and network installations. You do not have to have Internet
access to open and use HP ToolboxFX. HP ToolboxFX is only available following a Recommended
install.

Bf NOTE: HP ToolboxFX is not supported for Windows 2000, Windows Server 2003, or Macintosh
operating systems. To use HP ToolboxFX, you must have the TCP/IP protocol installed on your
computer.

Supported operating systems e  Microsoft Windows XP, Service Pack 2 (Home and
Professional editions)

e  Microsoft Windows Vista™

For more information about using HP ToolboxFX software, see Open HP ToolboxFX on page 67.

Other Windows components and utilities
e  Software installer — automates the printing system installation
e  Online Web registration
e  Print Quality Optimizer Video
e HP Basic Color Match (available on the Web)
e HP Easy Printer Care (available on the Web)
e  Web Printsmart (available on the Web)
e  HP SureSupply

e HP Print View Software (available on the Web)
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e Software for Macintosh

° Use features in the Macintosh printer driver
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Software for Macintosh

Supported operating systems for Macintosh
The product supports the following Macintosh operating systems:

° Mac OS X v10.3, v10.4, v10.5, and v10.6

Ef NOTE: For Mac OS X v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh

The HP installer provides PostScript® Printer Description (PPD) files and Printer Dialog Extensions
(PDEs) for use with Macintosh computers.

Remove software from Macintosh operating systems

You must have administrator rights to remove the software.

Mac OS X V10.3 and V10.4
1. Browse to the following folder:

Library/Printers/PPDs/Contents/Resources
2. Openthe <lang>.1lproj folder where <lang> is a two-letter language code.
3. Delete the .GZ file for this product.
4. Repeat steps 2 and 3 for each language folder.
Mac OS X V10.5

1. Browse to the following folder:

Library/Printers/PPDs/Contents/Resources

2. Delete the .GZ file for this product.

Priority for print settings for Macintosh

Changes to print settings are prioritized depending on where the changes are made:

B NOTE: The names of commands and dialog boxes might vary depending on your software program.

e Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here might override settings changed
anywhere else.

e Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.
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Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog

boxes.

Printer control panel settings: Settings changed at the printer control panel have a lower priority

than changes made anywhere else.

Change printer-driver settings for Macintosh

Supported utilities for Macintosh

Change the settings for all print jobs
until the software program is closed

Change the default settings for all
print jobs

Change the product configuration
settings

1.

2.

On the File menu, click Print.

Change the settings that you want
on the various menus.

1.

2,

On the File menu, click Print.

Change the settings that you want
on the various menus.

On the Presets menu, click Save
as and type a name for the preset.

These settings are saved in the

Presets menu. To use the new settings,

you must select the saved preset option

every time you open a program and print.

Mac OS X v10.3 or Mac OS X v10.4

1.

From the Apple menu, click System
Preferences and then Print &
Fax.

Click Printer Setup.

Click the Installable Options
menu.

Mac OS X v10.5 or Mac OS X v10.6

1.

From the Apple menu, click System
Preferences and then Print &
Fax.

Click Options & Supplies.

Click the Driver menu.

Select the driver from the list, and
configure the installed options.

View embedded Web server using a Macintosh

ENWW

The embedded Web server (EWS) is accessed by clicking the Utility button when viewing the print

queue. This opens a Web browser, such as Safari, which allows the user to access the EWS. The EWS

can also be accessed directly by typing the network IP address or DNS name of the product into the
Web browser.

HP USB EWS Gateway software, which is automatically installed, also allows a Web browser to access

the product if the product is connected using a USB cable. Click the Utility button when using a USB
connection to access the EWS though the Web browser.

Use the EWS to perform the following tasks:

View the product status and change product settings.

View and change network settings for the product.

Print information pages for the product.

View the product event log.

Software for Macintosh
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Use features in the Macintosh printer driver

Create and use printing presets in Macintosh

Use printing presets to save the current printer driver settings for reuse.

Create a printing preset

1. On the File menu, click Print.

2. Select the driver.

3.  Select the print settings.
4. Inthe Presets box, click Save As..., and type a name for the preset.
5

Click OK.

Use printing presets
1. On the File menu, click Print.
2. Select the driver.

3. Inthe Presets box, select the printing preset that you want to use.

Bf NOTE: To use printer-driver default settings, select Standard.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.
1. On the File menu, click Print.
2. Open the Paper Handling menu.

3. Inthe area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4. If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).
1. On the File menu, click Print.
2. Select the driver.

3. Open the Cover Page menu, and then select whether to print the cover page Before Document
or After Document.

4. Inthe Cover Page Type menu, select the message that you want to print on the cover page.

Bf NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks

A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.

1. On the File menu, click Print.
2. Open the Watermarks menu.

3.  Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4. Next to Pages, select whether to print the watermark on all pages or on the first page only.

5.  Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6. Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh

You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1 2
11234

1. On the File menu, click Print.

2.  Select the driver.

3.  Open the Layout menu.

4. Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4,6, 9, or 16).

5. Next to Layout Direction, select the order and placement of the pages on the sheet.

6. Next to Borders, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing)

/A CAUTION: To avoid jams, do not load paper that is heavier than 105 g/m? (28-lb bond) for automatic

ENWW

duplexing.
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Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

e Fortray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

e  For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

On the File menu, click Print.

Open the Layout menu.

Next to Two-Sided, select either Long-Edge Binding or Short-Edge Binding.
Click Print.

Insert enough paper into one of the trays to accommodate the print job. If you are loading special
paper such as letterhead, load it in one of the following ways:

e Fortray 1, load the letterhead paper face-up with the bottom edge feeding into the printer first.

e For all other trays, load the letterhead paper face-down with the top edge at the back of the
tray.

On the File menu, click Print.
On the Finishing menu, select Manually Print on 2nd Side.

Click Print. Follow the instructions in the pop-up window that appears on the computer screen
before replacing the output stack in tray 1 for printing the second half.

Go to the printer, and remove any blank paper that is in tray 1.

Insert the printed stack face-up with the bottom edge feeding into the printer first in tray 1. You
must print the second side from tray 1.

If prompted, press the appropriate control-panel button to continue.

Use the Color Options pop-up menu to control how colors are interpreted and printed from software
programs.

Click Show Advanced Options.

Adjust the individual settings for text, graphics, and photographs.

If the product is connected to a network, use the Services menu to obtain product and supply-status
information.

On the File menu, click Print.

Open the Services menu.
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e Supported network operating systems

° USB connection

e Supported network protocols

° Configure the product on the network
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Supported network operating systems

The following operating systems support network printing:

Windows Vista (Starter Edition, 32-bit, and 64-bit)
Windows Vista Server 2008 (32-bit)

Windows XP (32-bit, Service Pack 2)

Windows XP (64-bit, Service Pack 1)

Windows Server 2003 (Service Pack 1)

Windows 2000 (Service Pack 4)

Mac OS X v10.3, v10.4, v10.5, and v10.6

Bf NOTE: Notall network operating systems support a full software installation. See Supported operating

systems for Windows on page 18 and Supported operating systems for Macintosh on page 24.

Printer sharing disclaimer

HP does not support peer-to-peer networking, as the feature is a function of Microsoft operating systems

and not of the HP printer drivers. Go to Microsoft at www.microsoft.com.
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USB connection

B NOTE: Do notconnectthe USB cable before installing the software. The installation program will notify

you when the USB cable should be connected.

This product supports a USB 2.0 connection. You must use an A-to-B type USB cable for printing.

Supported network protocols

The product supports the TCP/IP network protocol. It is the most widely used and accepted networking
protocol. Many networking services utilize this protocol. This product also supports IPv4 and IPv6. The
following tables list the networking services/protocols that are supported on the product.

Table 5-1 Printing

Service name

Description

port 9100 (Direct Mode)

Printing service

Line printer daemon (LPD)

Printing service

ws-print

Microsoft plug-and-play printing solution

Table 5-2 Network product discovery

Service name

Description

SLP (Service Location Protocol)

Device Discovery Protocol, used to help find and configure
network devices. Used primarily by Microsoft-based software
programs.

Bonjour (also known as “Rendezvous” or “mDNS”)

Device Discovery Protocol, used to help find and configure
network devices. Used primarily by Apple Macintosh-based
software programs.

ws-discovery

Used by Microsoft-based software programs

ENWW

USB connection
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Table 5-3 Messaging and management

Service name

Description

HTTP (hypertext transfer protocol)

Allows Web browsers to communicate with embedded Web
server.

SNMP (simple network management protocol)

Used by network programs for product management. SNMP
V1 and standard MIB-II (Management Information Base)
objects are supported.

Table 5-4 IP addressing

Service name

Description

DHCP (dynamic host configuration protocol): IPv4 and IPv6

For Automatic IP address assignment. DHCP server provides
the product with an IP address. Generally requires no user
intervention for product to obtain IP address from a DHCP
server.

BOOTP (bootstrap protocol)

For Automatic IP address assignment. BOOTP server
provides the product with an IP address. Requires
administrator to input the product MAC hardware address in
the BOOTP server HOSTS file in order for the product to obtain
an |IP address from that server.

Auto IP

For Automatic IP address assignment. If neither a DHCP
server nor a BOOTP server is present, this service allows the
product to generate a unique IP address.

With manual IP addressing, you can manually provide an IP
address, subnet mask, and gateway address.
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Configure the product on the network

To configure network parameters on the product, use the product control panel, or the embedded Web
server. For Windows operating systems, use the HP ToolboxFX software. For Mac OS X, use the
Utility button.

Set up the product on the network

Hewlett-Packard recommends that you use the HP software installer on the product CD-ROM to set up
printer drivers for networks.

Bf NOTE: For Windows operating systems, you must connect the product to the network prior to starting
the software installation.

This product supports a 10/100 Base-T network connection. Plug the network cable into the product
and your network connection.

View settings

Network summary report

The network summary report lists the current settings and properties of the product network card. To
print the network summary report from the product, complete the following steps.

1. On the control panel, press the OK button.
2. Use the arrow buttons to select the Reports menu, and then press the OK button.

3. Use the arrow buttons to select the Network Summary option, and then press the OK button.

Configuration page

The configuration page lists the current settings and properties of the product. To print the configuration
page from the product, complete one of the following processes.

Use the control-panel buttons

A At the control panel, simultaneously press and hold the back button - and the cancel button (%).
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On the control panel, press the button.
Use the arrow buttons to select the Reports menu, and then press the button.

Use the arrow buttons to select Configuration Report, and then press the button.

Similar to a common language that people use to communicate with each other, TCP/IP (Transmission
Control Protocol/Internet Protocol) is a suite of protocols designed to define the way computers and
other devices communicate with each other over a network.

Every device on an IP network requires a unique IP address. This address can be manually set by the
user or can be obtained automatically, depending on the available network services.

An IPv4 address contains four bytes of information, divided into sections that each contain one byte.
The IP address has the following format:

B When assigning IP addresses, always consult the IP address administrator. Setting the wrong
address can disable other equipment operating on the network or interfere with communications.

IP configuration parameters can be configured manually, or they can be automatically downloaded by
using DHCP or BOOTP each time the product is turned on.

When turned on, a new product that is unable to retrieve a valid IP address from the network
automatically assigns itself a default IP address. On a small private network, a unique IP address in the
range of 169.254.1.0 to 169.254.254.255 is assigned. The IP address for the product is listed on the
product configuration page and the network report. See .

DHCP allows a group of devices to use a set of IP addresses that are maintained by a DHCP server.
The product sends a request to the server, and if an IP address is available, the server assigns it to that
product.

BOOTP is a bootstrap protocol used to download configuration parameters and host information from
a network server.

The product broadcasts a boot request packet that contains the product hardware address. The server
answers with a boot reply packet that contains the information that the product needs for configuration.

When an IP network address for a particular network class is assigned to an organization, no provision
is made for more than one network being present at that location. Local network administrators use
subnets to partition a network into several different subnetworks. Splitting a network into subnets can
result in better performance and improved use of limited network address space.
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The subnet mask is a mechanism used to divide a single IP network into several different subnetworks.
For a given network class, a portion of an IP address that would normally be used to identify a node is
used, instead, to identify a subnetwork. A subnet mask is applied to each IP address to specify the
portion used for subnetworks, and the portion used to identify the node.

Gateways (routers) are used to connect networks together. Gateways are devices that act as translators
between systems that do not use the same communication protocols, data formatting, structures,
languages, or architectures. Gateways repackage the data packets and change the syntax to match
that of the destination system. When networks are divided into subnets, gateways are required to
connect one subnet to another.

The default gateway is the IP address of the gateway or router that moves packets between networks.

If multiple gateways or routers exist, then the default gateway is typically the address of the first, or
nearest, gateway or router. If no gateways or routers exist, then the default gateway will typically assume
the IP address of the network node (such as the workstation or product).

You can configure the IP address manually or automatically via DHCP, BootP, or Auto IP.

2 When assigning IP addresses, always consult the IP address administrator. Setting the wrong
address can disable other equipment operating on the network or interfere with communications.

On the control panel, press the button.

Use the arrow buttons to select the Network Configuration menu, and then press the button.
Use the arrow buttons to select the TCP/IP Configuration menu, and then press the button.
Use the arrow buttons to select the Manual option, and then press the button.

Press the right arrow button » to increase the value for the first section of the IP address. Press
the left arrow button « to decrease the value. When the value is correct, press the button.
Repeat this process for the other three sections of the IP address.

If the address is correct, use the arrow buttons to select the Yes option, and then press the
button. Select a subnet mask and repeat step 5 for the default gateway settings.

-or-

If the IP address is incorrect, use the arrow buttons to select the No option, and then press the
button. Repeat step 5 to establish the correct IP address, and then select a subnet mask and
repeat step 5 for the default gateway settings.
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B The Automatic option is the default Network Configuration TCP/IP Configuration setting.

On the control panel, press the button.

Use the arrow buttons to select the Network Configuration menu, and then press the button.
Use the arrow buttons to select the TCP/IP Configuration menu, and then press the button.
Use the arrow buttons to select the Automatic option, and then press the button.

It might take several minutes before the automatic IP address is ready for use.

B To disable or enable specific automatic IP modes (such as BOOTP, DHCP, or AutolP), use
the embedded Web server or HP ToolboxFX.

B When the Show IP address setting is On, the IP address appears on the control-panel display.
On the control panel, press the button.
Use the arrow buttons to select the Network Configuration menu, and then press the button.
Use the arrow buttons to select the Show IP address menu, and then press the button.

Use the arrow buttons to select the Yes or No option, and then press the button.

On the control panel, press the button.
Use the arrow buttons to select the Network Configuration menu, and then press the button.
Use the arrow buttons to select the Auto Crossover menu, and then press the button.

Use the arrow buttons to select the On or Off option, and then press the button.

On the control panel, press the button.

Use the arrow buttons to select the Network Configuration menu, and then press the button.
Use the arrow buttons to select the Network Services menu, and then press the button.
Use the arrow buttons to select the IPv4 or IPv6 menu, and then press the button.

Use the arrow buttons to select the On or Off option, and then press the button.

Selecting the Off option disables the product IPv4/IPv6 networking.

On the control panel, press the button.

Use the arrow buttons to select the Network Configuration menu, and then press the button.
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Use the arrow buttons to select the Link Speed menu, and then press the button.

Use the arrow buttons to select one of the link speed options, and then press the button.

On the control panel, press the button.
Use the arrow buttons to select the Network Configuration menu, and then press the button.
Use the arrow buttons to select the Restore Defaults menu, and then press the button.

Press the button to restore the default network settings. Press the cancel button %) to exit the
menu without restoring the default network settings.
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° Understand paper and print media use

e  Supported paper and print media sizes

e  Supported paper types and tray capacity

e  Supported paper sizes for duplex printing

e  Special paper or print media guidelines

° Load trays
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Understand paper and print media use

This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:

e  Poor print quality
e Increased jams
e Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laser printers or multiuse. Do
not use paper or print media made for inkjet printers. Hewlett-Packard Company cannot recommend
the use of other brands of media because HP cannot control their quality.

It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.

/A CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
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Supported paper and print media sizes

This product supports a number of paper sizes, and it adapts to various media.

Bf NOTE: To obtain best print results, select the appropriate paper size and type in your print driver before

ENWW

printing.

Table 6-1 Supported paper and print media sizes

Size Dimensions Tray 1 Tray 2 Optional Tray 3
Letter 216 x 279 mm (8.5 x 11 in) ‘/ ‘/ ‘/
Legal 216 x 356 mm (8.5 x 14 in) ‘/ ‘/ ‘/
A4 210 x 297 mm (8.27 x 11.69 in) / / /
Executive 184 x 267 mm (7.25 x 10.5 in) / / /
A3 297 x 420 mm (11.69 x 16.54 in) / / /
A5 148 x 210 mm (5.83 x 8.27 in) / /
A6 105 x 148 mm (4.13 x 5.83 in) /
B4 (JIS) 257 x 364 mm (10.12 x 14.33 in) v v v
B5 (JIS) 182 x 257 mm (7.17 x 10.12 in) / / /
8k 270 x 390 mm (10.6 x 15.4 in)

260 x 368 mm (10.2 x 14.5 in) v v v

273 x 394 mm (10.75 x 15.5in)
16k 184 x 260 mm (7.24 x 10.23 in)

195 x 270 mm (7.68 x 10.62 in) v v

197 x 273 mm (7.75 x 10.75 in)
8.5x 13 (Folio) 216 x 330 mm (8.5 x 13in) \/ \/ \/
Index card 76 x 127 mm (3 x 5 in)’

107 x 152 mm (4 x 6 in) v

127 x 203 mm (5 x 8 in)
10x 15cm 100 x 150 mm (3.9 x 5.9 in) \/
11x1.7 279 x 432 mm (11 x 17 in) \/ \/ \/
(Tabloid)
12x18 (ArchB) 305 x 457 mm (12 x 18 in) ‘/
RA3 305 x 430 mm (12 x 16.9 in) v
SRA3 320 x 450 mm (12.6 x 17.7 in) /

Supported paper and print media sizes
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Table 6-1 Supported paper and print media sizes (continued)

Size Dimensions

Optional Tray 3

Custom Minimum: 76 x 127 mm (3 x 5 in)

Maximum: 320 x 470 mm (12.6 x 18.5 in)

Minimum: 148 x 182 mm (5.8 x 7.1 in)

Maximum: 297 x 432 mm (11.7 x 17 in)

Minimum: 210 x 148 mm (8.3 x 5.8 in)

Maximum: 297 x 432 mm (11.7 x 17 in)

' This size is not listed in the printer driver or product firmware, but is supported as a custom size.

Table 6-2 Supported envelopes and postcards

Size Dimensions

Tray 2

Envelope #10 105 x 241 mm (4.13 x 9.49 in)

Tray 1

v
Envelope DL 110 x 220 mm (4.33 x 8.66 in) ‘/
Envelope C5 162 x 229 mm (6.93 x 9.84 in) ‘/
Envelope B5 176 x 250 mm (6.7 x 9.8 in) ‘/
Envelope 98 x 191 mm (3.9 x 7.5 in) ‘/
Monarch
Postcard 100 x 148 mm (3.94 x 5.83 in) ‘/

v

Double postcard 148 x 200 mm (5.83 x 7.87 in)
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Supported paper types and tray capacity

Media type

Dimensions'’ Weight

Capacity”

Paper orientation

Paper, including the

following types:

Plain
Letterhead
Color
Preprinted
Prepunched

Recycled

Tray 1 minimum:
76 x 127 mm (3 x 5 in)

Tray 1 maximum:
320 x 470 mm
(12.6 x 18.5in)

Tray 2 minimum: 148 x
182 mm (5.8 x 7.1in)

Tray 3 minimum: 210 x
148 mm (8.3 x 5.8 in)

Tray 2 or Tray 3
maximum: 297 x 432 mm
(11.7 x 17 in)

NOTE: If the paper
width is 297 mm (11.7 in),
the maximum height
cannot exceed 420 mm
(16.54 in). If the paper
width is 279 mm (11 in),
the maximum height
cannot exceed 297
mm432 mm ( 17 in).

60t0 105 g/m? (16 to 28 Ib)

Tray 1: up to 100 sheets

Tray 2: up to 250 sheets of
75 g/m? (20 Ib bond)

Tray 3: up to 500 sheets of
75 g/m? (20 Ib bond)

Tray 1: Side to be printed
on face-down, with the top
edge at the back of the
tray

Trays 2 and 3: Side to be
printed on face-up, with
the top edge at the back of
the tray

Heavy paper

Same as for paper Tray 1: Up to 220 g/m?

(58 Ib)

Trays 2 and 3: Up to
120 g/m? (32 Ib)

Tray 1: up to 10 mm
(0.4in)

Tray 2: up to 25 mm
(0.98 in) stack height

Tray 3: up to 51 mm (2 in)
stack height

Tray 1: Side to be printed
on face-down, with the top
edge at the back of the
tray

Trays 2 and 3: Side to be
printed on face-up, with
the top edge at the back of
the tray

Cover paper

Same as for paper Tray 1: Up to 220 g/m?

(58 Ib)

Trays 2 and 3: Up to
120 g/m? (32 Ib)

Tray 1: up to 10 mm
(0.4 in)

Tray 2: up to 25 mm
(0.98 in) stack height

Tray 3: up to 51 mm (2 in)
stack height

Tray 1: Side to be printed
on face-down, with the top
edge at the back of the
tray

Trays 2 and 3: Side to be
printed on face-up, with
the top edge at the back of
the tray

Glossy paper

Photo paper

Same as for paper Tray 1: Up to 220 g/m?

(58 Ib)

Trays 2 and 3: Up to
160 g/m? (43 Ib)

Tray 1: up to 10 mm
(0.4 in)

Tray 2: up to 25 mm
(0.98 in) stack height

Tray 3: up to 51 mm (2 in)
stack height

Tray 1: Side to be printed
on face-down, with the top
edge at the back of the
tray

Trays 2 and 3: Side to be
printed on face-up, with
the top edge at the back of
the tray

Transparencies

A4 or Letter Thickness: 0.12 to

0.13 mm (4.7 to 5.1 mils)

Tray 1: up to 10 mm
(0.4in)

Side to be printed on face-
down, with the top edge at
the back of the tray
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Media type Dimensions' Weight Capacity” Paper orientation

Labels® A4 or Letter Thickness: up to 0.23 mm Tray 1: up to 10 mm Side to be printed on face-
(9 mils) (0.4 in) down, with the top edge at
the back of the tray
Envelopes e COM10 Up to 90 g/m? (24 Ib) Tray 1:upto 10 envelopes Side to be printed on face-
down, with the stamp-end
e  Monarch at the back of the tray
s DL
e C5
° B5
Postcards or index cards 100 x 148 mm Tray 1: up to 10 mm Side to be printed on face-
(3.9x5.8in) (0.4 in) down, with the top edge at
the back of the tray

1 The product supports a wide range of standard and custom sizes of print media. Check the printer driver for supported sizes.
2 Capacity can vary depending on media weight and thickness, and environmental conditions.
3 Smoothness: 100 to 250 (Sheffield)

Supported paper sizes for duplex printing
e  Minimum: 148 x 182 mm (5.8 x 7.1 in)
e  Maximum: 320 x 450 mm (12.6 x 18 in)

B NOTE: For automatic duplexing, do not load paper that is heavier than 105 g/m? (28-Ib bond). Use
manual duplexing to print on heavier paper. For information about manual duplexing, see Set document
finishing options on page 52 for Windows or Print on both sides manually on page 28 for Mac.

44 Chapter 6 Paper and print media ENWW



Special paper or print media guidelines

This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in the printer driver

to obtain the best results.

/A CAUTION: HP LaserJet products use fusers to bond dry toner particles to the paper in very precise

ENWW

dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper could damage the

product.
Media type Do Do not
Envelopes o  Store envelopes flat. o Do not use envelopes that are
wrinkled, nicked, stuck together, or
e  Use envelopes where the seam otherwise damaged.
extends all the way to the corner of
the envelope. ° Do not use envelopes that have
clasps, snaps, windows, or coated
e  Use peel-off adhesive strips that linings.
are approved for use in laser
printers. o Do not use self-stick adhesives or
other synthetic materials.
Labels e  Use only labels that have no o Donotuse labels that have wrinkles
exposed backing between them. or bubbles, or are damaged.
e  Use labels that lie flat. o Do not print partial sheets of labels.
e  Use only full sheets of labels.
Transparencies e Use only transparencies that are o Do not use transparent print media

approved for use in laser printers.

Place transparencies on a flat
surface after removing them from
the product.

not approved for laser printers.

Letterhead or preprinted forms

Use only letterhead or forms
approved for use in laser printers.

° Do not use raised or metallic
letterhead.

Heavy paper

Use only heavy paper that is
approved for use in laser printers
and meets the weight specifications
for this product.

e Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper

Use only glossy or coated paper
that is approved for use in laser
printers.

o Do not use glossy or coated paper
designed for use in inkjet products.

Special paper or print media guidelines
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Load trays

Load Tray 1
1. Open Tray 1.

2. Ifloading long sheets of media, pull out the extension tray.
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3. Extendthe paper guides fully (callout 1) and then load the media stack into Tray 1 (callout 2). Adjust
the paper guides to the size of the paper.

B NOTE: Place the media into Tray 1 with the side to be printed on face-down and either the top
(rotated media) or right edge toward the product.

Load Tray 2 or 3
1. Pull the tray out of the product.
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3. Place the paper face-up in the tray and make sure that it is flat at all four corners. Slide the paper
length and width guides so that they are against the stack of paper.

Ef NOTE: The following sizes should not be rotated: letter, A4, Executive, and B5 (JIS). Load those
media types so that the long edge is against the right side of the tray.

4. Push down on the paper to make sure that the paper stack is below the paper limit tabs on the side
of the tray.

5. Slide the tray into the product.
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Print tasks

e Cancel a print job

° Use features in the Windows printer driver
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Cancel a print job

You can stop a print request by using the product control panel or using your software program. For
instructions on how to stop a print request from a computer on a network, see the online Help for the
specific network software.

Ef NOTE: It can take some time for all printing to clear after you have canceled a print job.

Cancel the current print job at the product control panel

Press the cancel button (% on the control panel.

B NOTE: If the print job has proceeded too far, you might not have the option to cancel it.

Cancel the current print job from the software program
A dialog box might appear briefly on the screen, giving you the option to cancel the print job.

If several requests have been sent to the product through your software, they might be waiting in a print
queue (for example, in Windows Print Manager). See the software documentation for specific
instructions about canceling a print request from the computer.

If a print job is waiting in a print queue (computer memory) or print spooler (Windows 2000, XP, or Vista),
delete the print job there.

For Windows 2000, Windows XP, or Windows Vista, click Start and then click Printers and Faxes; or
click Start, click Control Panel, and then click Printers and Faxes. Double-click the printer icon to open
the print spooler. Select the print job that you want to cancel, and then click Cancel or Delete under the
Document menu. If the print job is not canceled, you might need to shut down and restart the computer.

50 Chapter 7 Print tasks ENWW



Use features in the Windows printer driver

Open the printer driver

How do |

Steps to perform

Open the printer driver

On the File menu in the software program, click Print. Select
the printer, and then click Properties or Preferences.

Get help for any printing option

Click the ? symbol in the upper-right corner of the printer driver,
and then click any item in the printer driver. A pop-up message
displays that provides information about the item. Or, click
Help to open the online Help.

Use printing shortcuts

To perform the following tasks, open the printer driver and click the Printing Shortcuts tab.

Bf NOTE: In previous HP printer drivers, this feature was called Quick Sets.

How do |

Steps to perform

Use a printing shortcut

Select one of the shortcuts, and then click OK to print the job
with the predefined settings.

Create a custom printing shortcut

a) Select an existing shortcut as a base. b) Select the print
options for the new shortcut. c) Click Save As, type a name for
the shortcut, and click OK.

Set paper and quality options

To perform the following tasks, open the printer driver and click the Paper/Quality tab.

How do |

Steps to perform

Select a page size

Select a size from the Paper size drop-down list.

Select a custom page size

a) Click Custom. The Custom Paper Size dialog box opens.
b) Type a name for the custom size, specify the dimensions,
and click OK.

Select a paper source

Select a tray from the Paper source drop-down list.

Select a paper type

Select a type from the Paper type drop-down list.

Print covers on different paper

Print the first or last page on different paper

a) In the Special pages area, click Covers or Print pages on
different paper, and then click Settings. b) Select an option
to print a blank or preprinted front cover, back cover, or both.
Or, select an option to print the first or last page on different
paper. c) Select options from the Paper source and Paper
type drop-down lists, and then click Add. d) Click OK.

Set document effects

To perform the following tasks, open the printer driver and click the Effects tab.

ENWW

Use features in the Windows printer driver
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How do | Steps to perform

Scale a page to fit on a selected paper size Click Print document on, and then select a size from the drop-
down list.

Scale a page to be a percent of the actual size Click % of actual size, and then type the percent or adjust the
slider bar.

Print a watermark a) Select a watermark from the Watermarks drop-down list.

b) To print the watermark on the first page only, click First page
only. Otherwise, the watermark is printed on each page.

Add or edit watermarks a) In the Watermarks area, click Edit. The Watermark

Details dialog box opens. b) Specify the settings for the
NOTE: The printer driver must be installed on your computer watermark, and then click OK.
rather than a server for this to work.

Set document finishing options

Manually printing on both sides

Select the Print on Both Sides (Manually) check box to print on the second side of the paper for the
base models. The base models do not have automatic duplexing capability. Print on Both Sides
(Manually) will also be enabled for duplex models when a paper type is selected that cannot be auto-
duplexed.

Make sure to select the correct paper type as selecting a paper type instructs the product to use a group
of settings (such as fuser temperature and print speed) to print the paper with the best possible quality.
This group of settings is known as print mode. To achieve the best print quality when printing on the
second side of the page, the product makes adjustments to its print modes. A different print mode is
used with each paper type. Print-mode adjustments for the second side of a duplexed page are
automatic.

The following paper types cannot be manually duplexed using the Print on both sides (Manually)
feature:

e HP Color Laser Photo Glossy 220g
e Labels

e Envelope

e Heavy Envelope

e Color Laser Transparency

A triangle enclosing an exclamation point icon appears next to the Color Laser Transparency,
Envelope, Heavy Envelope, and Labels options. This icon indicates that duplex printing is not advised
for these paper types.
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To make the Print on Both Sides (Manually) check box available in the document options, enable the
Allow Manual Duplexing option on the Device Settings tab in the Properties print-driver tabs.

1.

D @ DbN

In Windows Vista, click Computer, click Control Panel, and then click Hardware and Sound.

In Windows XP Professional and Windows Server 2003, click Start, click Settings, and then click
Printers and Faxes.

-or-

In Windows XP Home, click Start, click Control Panel, and then double-click the Printers and
Other Hardware icon.

-or-
For Windows 2000: Select Settings, and then click Printers.
Right-click the product icon.

Click Properties.

Click Device Settings tab.

Look for the Installable Options section at the bottom of Device Settings screen. Select “Enabled”
for the “Allow Manual Duplexing” option.

When the Print on Both Sides (Manually) check box is available on the Document Options section
of the Finishing tab screen, follow these steps to make the HP Color LaserJet CP5220 Series printer
manually print on both sides.

1.

Select the Print on Both Sides (Manually) check box.
Click OK.

Click Print. The even-number pages of the document print.

When the control panel shows the Load tray 1. Press [OK] to continue. Alternating with Manual
Duplex. message, insert the stack of paper on which the even-numbered pages have been printed.

Figure 7-1 Finishing tab — Print on Both Sides instruction window
Print on Botfid:s Instructions ﬁ

Mfter the even numbered pages have printed, a message will appear on the prnter's display instructing you
where to load the paper. Follow the instructions below to peint the odd-numbered pages (second sides)

1. Note the location of the 2. Fipthe paperstack overalong | | 3 Insed the paper stack into
short edge of your paper. the short edge as shown Tray 1 printed side UP, the
Remove the paper stack short edge oriented the
from the Output Bin. Do same as in Step 1
not discard blank sheets. Press the Go or Select

button to continue printing.

—

Use features in the Windows printer driver
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5.  Click the OK button on the product control panel.

6. The odd numbered pages print on the second side (blank) of the stacked sheets.

Print a booklet

a) Click Print on both sides. b) In the Booklet layout drop-down list, click Left binding or Right
binding. The Pages per sheet option automatically changes to 2 pages per sheet.

Print multiple pages per sheet

a) Select the number of pages per sheet from the Pages per sheet drop-down list. b) Select the correct
options for Print page borders, Page order, and Orientation.

Select page orientation

a) In the Orientation area, click Portrait or Landscape. b) To print the page image upside down, click
Rotate by 180 degrees.

Obtain support and product-status information

To perform the following tasks, open the printer driver and click the Services tab.

How do | Steps to perform

Obtain support information for the product and order supplies In the Internet Services drop-down list, select a support
online option, and click Go!

Set advanced printing options

To perform the following tasks, open the printer driver and click the Advanced tab.

How do | Steps to perform

Select advanced printing options In any of the sections, click a current setting to activate a drop-
down list so you can change the setting.

Change the number of copies that are printed Open the Paper/Output section, and then enter the number of
copies to print. If you select 2 or more copies, you can select

NOTE: If the software program that you are using does not  the option to collate the pages.

provide a way to print a particular number of copies, you can

change the number of copies in the driver.

Changing this setting affects the number of copies for all print
jobs. After your job has printed, restore this setting to the
original value.

Print colored text as black rather than as shades of gray a) Open the Document Options section, and then open the
Printer Features section. b) In the Print All Text as Black
drop-down list, select Enabled.
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How do | Steps to perform

Load letterhead or preprinted paper the same way for every ~ a) Open the Document Options section, and then open the

job, whether printing on one or both sides of the page Printer Features section. b) In the Alternative Letterhead
Mode drop-down list, select On. c) At the product, load the
paper the same way you would for printing on both sides.

Change the order in which pages are printed a) Open the Document Options section, and then open the
Layout Options section. b) In the Page Order drop-down list,
select Front to Back to print the pages in the same order as
they are in the document, or select Back to Front to print the
pages in the reverse order.
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8 Color for Windows

° Manage color

° Match colors

e Advanced color use

ENWW
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Manage color

Manage color by changing the settings on the Color tab in the printer driver.

Automatic

Setting color options to Automatic typically produces the best possible print quality for color documents.
The Automatic color adjustment option optimizes the neutral-gray color treatment, halftones, and edge
enhancements for each element in a document. For more information, see your printer driver online

Help.

Ef NOTE: Automatic is the default setting and is recommended for printing all color documents.

Print in Grayscale

Select the Print in Grayscale option from the printer driver to print a color document in black and white.
This option is useful for printing color documents that will be photocopied or faxed.

When Print in Grayscale is selected, the product uses the monochrome mode, which reduces use of

the color cartridges.

Manual color adjustment

Use the Manual color adjustment option to adjust the neutral-gray color treatment, halftones, and edge
enhancements for text, graphics, and photographs. To gain access to the manual color options, from
the Color tab, select Manual, and then select Settings.

Manual color options

Use manual color options to adjust the Neutral Grays, Halftone, and Edge Control options for text,

graphics, and photographs.

Table 8-1 Manual color options

Setting description Setting options

Neutral Grays °

The Neutral Grays setting determines the method for
creating gray colors used in text, graphics, and

Black Only generates neutral colors (grays and black) by using
only black toner. This guarantees neutral colors without a color
cast. This setting is best for documents and grayscale viewgraphs.

photographs. e 4-Color generates neutral colors (grays and black) by combining
all four toner colors. This method produces smoother gradients
and transitions to other colors, and it produces the darkest black.

Edge Control e Maximum is the most aggressive trapping setting. Adaptive
halftoning is on.

The Edge Control setting determines how edges are

rendered. Edge control has two components: ° Normal sets trapping at a medium level. Adaptive halftoning is on.

adaptive halftoning and trapping. Adaptive halftoning

increases edge sharpness. Trapping reduces the e Light sets trapping at a minimal level, Adaptive halftoning is on.

effect of color-plane misregistration by overlapping

the edges of adjacent objects slightly. e  Off turns off both trapping and adaptive halftoning.

Color themes

Use color themes to adjust the RGB Color options for the entire page.
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Setting description

Setting options

RGB Color

Default (sRGB) instructs the product to interpret RGB color as
sRGB. The sRGB standard is the accepted standard of Microsoft
and the World Wide Web Consortium (www.w3.0rg).

Vivid (sRGB) instructs the product to increase the color saturation
in the midtones. Less colorful objects are rendered more colorfully.
This setting is recommended for printing business graphics.

Photo (sRGB) interprets RGB color as if it were printed as a
photograph using a digital mini-lab. It renders deeper, more
saturated colors differently than Default (SRGB) mode. Use this
setting for printing photos.

Photo (Adobe RGB 1998) is for digital photos that use the Adobe
RGB color space rather than sRGB. When printing from a
professional software program that uses Adobe RGB, it is
important to turn off the color management in the software program
and allow the product to manage the color space.

None sets the product to print RGB data in raw device mode. To
render photographs correctly when this option is selected, you
must manage color in the program in which you are working or in
the operating system.

Manage color
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For most users, the best method for matching colors is to print SRGB colors.

The process of matching printer output color to your computer screen is complex, because printers and
computer monitors use different methods of producing color. Monitors display colors by using light pixels
that use an RGB (red, green, blue) color process, but printers print colors by using a CMYK (cyan,
magenta, yellow, and black) process.

Several factors can influence your ability to match printed colors to those on your monitor:
Print media
Printer colorants (inks or toners, for example)
Printing process (inkjet, press, or laser technology, for example)
Overhead lighting
Personal differences in perception of color
Software programs
Printer drivers
Computer operating systems
Monitors
Video cards and drivers
Operating environment (humidity, for example)

Keep these factors in mind when colors on your screen do not perfectly match your printed colors.

You can use HP ToolboxFX to print a palette of the Microsoft Office Basic Colors. Use this palette to
select the colors that you want to use in printed documents. It shows the actual colors that print when
you select these basic colors in a Microsoft Office program.

In HP ToolboxFX, select the Help folder.
In the Color Printing Tools section, select Print Basic Colors.

Adjust color in your document to match the color selection on the printed color palette.

The HP Basic Color Match tool allows you to adjust spot color in your printed output. For example, you
can match the color of your company logo on your printed output. You can save and use the new color
schemes for specific documents or all printed documents, or you can create multiple color schemes that
you can choose from later.

This software tool is available to all users of this product. Before you can use the tool, you must download
it from the Web through HP ToolboxFX or the software CD that came with your product.
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Use the following procedure to download the HP Basic Color Match tool through the software CD.
Insert the CD into your CD-ROM drive. The CD autoruns.
Select Install more software.

Select HP Basic Color Match. The tool downloads and installs itself. A desktop icon is also
created.

Use the following procedure to download the HP Basic Color Match tool through HP ToolboxFX.
Open HP ToolboxFX.
Select the Help folder.

In the Color Printing Tools section, select Basic Color Match. The tool downloads and installs
itself. A desktop icon is also created.

After the HP Basic Color Match tool is downloaded and installed, it can be run from the desktop icon or
from HP ToolboxFX (click the Help folder, and then Color Printing Tools, and then Basic Color
Match). The tool guides you through selecting colors. All color matches selected are saved as a color
theme and can be accessed in the future.

You can use HP ToolboxFX to print a palette of custom colors. In the Toolbox Color Printing Tools

section, click View Custom Colors. Tab to the color page desired and print the current page. In your
document, type the red, green, and blue values in the software's custom color menu to change them to
match the color on the palette.

Match colors
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The product provides automatic color features that generate excellent color results. Carefully designed
and tested color tables provide smooth, accurate color rendition of all printable colors.

The product also provides sophisticated tools for the experienced professional.

HP designs the print system (printer, print cartridges, toner, and paper) to work together to optimize print
quality, product reliability, and user productivity. Original HP print cartridges contain HP ColorSphere
toner that is specifically matched to your printer so that it will produce a wide range of brilliant colors.
This helps you create professional looking documents that contain sharp, clear text and graphics and
realistic printed photos.

HP ColorSphere toner produces print-quality consistency and intensity you can depend on across a
wide range of papers That means you can produce documents that help you make the right impression.
Plus, HP professional-quality everyday and specialty papers (including a wide variety of HP media types
and weights) are designed for the way you work.

ImageREt 3600 provides color laser-class equivalent to a 3600 dots-per-inch (dpi) press through a multi-
level printing process. This process precisely controls color by combining up to four colors within a single
dot and by varying the amount of toner in a given area. ImageREt 3600 has been improved for this
product. The improvements offer trapping technologies, greater control over dot placement, and more
precise control of toner quality in a dot. These new technologies, coupled with HP's multi-level printing
process, result in a 600 x 600 dpi printer that provides 3600-dpi color laser-class quality with millions of
smooth colors.

For the best color and image quality, select the appropriate media type from the software printer menu
or from the printer driver.

Color options automatically provide optimal color output. These options use object tagging, which
provides optimal color and halftone settings for different objects (text, graphics, and photos) on a page.
The printer driver determines which objects appear on a page and uses halftone and color settings that
provide the best print quality for each object.

In the Windows environment, the Automatic and Manual color options are on the Color tab in the printer
driver.

Standard red-green-blue (sRGB) is a worldwide color standard that HP and Microsoft developed as a
common color language for monitors, input devices (scanners and digital cameras), and output devices
(printers and plotters). It is the default color space used for HP products, Microsoft operating systems,
the World Wide Web, and most office software. The sRGB standard represents the typical Windows
monitor and is the convergence standard for high-definition television.

B Factors such as the type of monitor you use and the room lighting can affect the appearance
of colors on your screen. For more information, see
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The latest versions of Adobe PhotoShop®, CoreDRAW®, Microsoft Office, and many other programs
use sRGB to communicate color. Because it is the default color space in Microsoft operating systems,
SRGB has been adopted broadly. When programs and devices use sRGB to exchange color information,
typical users experience greatly improved color matching.

The sRGB standard improves your ability to match colors between the product, the computer monitor,
and other input devices automatically, and eliminates the need to become a color expert.
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° HP ToolboxFX
° Embedded Web server

° Manage supplies

° Change print cartridges

° Memory and font DIMMs

° Clean the product

° Firmware updates
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Use the control panel to print information pages that give details about the product and its current
settings.

Press the button to open the menus.
Use the arrow buttons to select the Reports menu, and then press the button.

Use the arrow buttons to navigate through the reports, and then press the button to print a
report.

Press the cancel button (¥ to exit the menus.
The following information pages are available:

Demo Page

Menu Structure

Configuration Report

Supplies Status

Network Summary

Usage Page

PCL Font List

PS Font List

PCL6 Font List

Color Usage Log

Service Page

Diagnostics Page
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HP ToolboxFX
Open HP ToolboxFX

Open HP ToolboxFX in one of these ways:

ENWW

In the Windows system tray, double-click the HP ToolboxFX icon (i&).

On the Windows Start menu, click Programs (or All Programs in Windows XP and Vista), click
HP, click HP Color LaserJet CP5220 Series, and then click HP ToolboxFX.

HP ToolboxFX contains the following folders:

Status (see Status on page 68)

Alerts (see Alerts on page 69)

Product information (see Product information on page 69)

Help (see Help on page 70)

System Settings (see System Settings on page 71)

Print Settings (see Print Settings on page 74)

Network Settings (network models only) (see Network Settings on page 74)
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The Status folder contains links to the following main pages:

Device status. This page indicates product conditions such as a jam or an empty tray. After you
correct a problem, click Refresh status to update the product status.

Supplies status. View details such as the approximate percent of toner remaining in the print
cartridge and the approximate number of pages that have been printed with the current print
cartridge. This page also has links for ordering supplies and for finding recycling information.

Device configuration. View a detailed description of the current product configuration, including
the amount of memory installed and whether optional trays are installed.

Network summary. View a detailed description of the current network configuration, including the
IP address and network status.

Reports. Print the configuration page and other information pages, such as the supplies status
page. See

Color usage job log. View color usage information for recently printed documents.

Event log. View a history of product events. The most recent event is listed first.

The event log is a table that contains codes corresponding to error messages that have appeared on
the product control-panel display, a brief description of each error, and the number of pages that printed
when each error occurred. For more information about error messages, see
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The Alerts folder contains links to the following main pages:

Set up Status Alerts. Set up the product to send you pop-up alerts for certain events, such as low
levels of cartridge life.

Set up E-mail Alerts. Set up the product to send you e-mail alerts for certain events, such as low
levels of cartridge life.

Use this to set up the product so that it sends alerts to your computer when jams, low levels of cartridge
life in HP print cartridges, a non-HP print cartridge in use, empty input trays, and specific error messages
occur.

Select to receive a pop-up, a system tray icon, a desktop alert, or any combination of these. The pop-
up and desktop alerts only appear when the product is printing from the computer on which you set up
the alerts. Desktop alerts are only visible momentarily, and disappear automatically.

Change the Cartridge low threshold setting, which sets the toner level that causes a low toner alert,
on the System setup page.

You must click Apply before your changes take effect.

Use this to configure up to two e-mail addresses to receive alerts when certain events occur. You can
specify different events for each e-mail address. Use the information for the e-mail server that will send
out the e-mail alert messages for the product.

You can only configure e-mail alerts to be sent from a server that does not require user
authentication. If your e-mail server requires you to log in with a username and password, you cannot
enable e-mail alerts.

You must click Apply before your changes take effect.

The Product information folder contains links to the following page:

Demonstration Pages. Print pages that show the color print quality potential and overall print
characteristics of the product.

Use HP ToolboxFX or the embedded Web server to set a system password.
In the embedded Web server, click the System tab.
In HP ToolboxFX, click the Device Settings tab.
Click Product Security.

In the Password box, type the password that you want to set, and then in the Confirm
password box, type the same password again to confirm your choice.

Click Apply to save the password.

HP ToolboxFX
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74 If a password has already been set, you are prompted for it. Type the password, and then
click Apply.

The Help folder contains links to the following main pages:

Troubleshooting. View troubleshooting help topics, print troubleshooting pages, clean the
product, and open Microsoft Office Basic Colors. For more information about Microsoft Office Basic
Colors, see

Paper and Print Media. Print information about how to obtain optimal results from your product
using various types of paper and print media.

Color Printing Tools. Open Microsoft Office Basic Colors or the full palette of color with associated
RGB values. For more information about Microsoft Office Basic Colors, see
. Use the HP Basic Color Match to adjust spot colors in your printed output.

Animated Demonstrations. View animations that demonstrate how to perform common tasks on
your product, such as how to get the best print quality, how to remove paper jams, and how to
replace a print cartridge.

User Guide. View information about the product usage, warranty, specifications, and support. The
User Guide is available in both HTML and PDF format.
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The System Settings folder contains links to the following main pages:
Device Information. View information such as the product description and a contact person.

Paper Setup. Configure trays or change the product paper-handling settings, such as default paper
size and default paper type.

Print Quality. Change the print-quality settings.

Print Density. Change the print-density settings, such as contrast, highlights, midtones, and
shadows.

Paper Types. Change the mode settings for each media type, such as letterhead, prepunched, or
glossy paper.

Extended Print Modes. Change the product fuser mode settings to enhance print quality.

System Setup. Change the system settings, such as jam recovery and auto-continue. Change the
low cartridge setting, which sets the toner level that causes a low toner alert.

Save/Restore Settings. Save the current settings for the product to a file on your computer. Use
this file to load the same settings onto another product or to restore these settings to this product
at a later time.

Product Security. Set a password to protect the product settings. Once a password is set, users
will be prompted to enter the password before being allowed to change product settings. Setting
the password on this page also sets the embedded Web server password.

This page stores data about the product for future reference. The information that you type in the fields
on this page appears on the configuration page. You can type any character in each of these fields.

28 You must click Apply before your changes take effect.
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Use these options to configure your default settings. These are the same options that are available on
the control-panel menus on the control panel. For more information, see

The following options are available for handling print jobs when the product is out of media:
Select Wait for paper to be loaded.
Select Wait forever from the Paper out action drop-down list to wait indefinitely.
Select Cancel from the Paper out action drop-down list to cancel the print job.

Select Override from the Paper out action drop-down list to send the print job to another paper
tray.

The Paper out time field specifies how long the product waits before acting on your selections. You
can specify from 0 to 3600 seconds.

74 You must click Apply before your changes take effect.
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Use these options to improve the appearance of your print jobs. These are the same options that are
available on the control panel menus. For more information, see

Power On Calibration. Specify whether the product should calibrate when you turn it on.
Calibration Timing. Specify how frequently the product should calibrate.
Calibrate Now. Set the product to calibrate immediately.

4 You must click Apply before your changes take effect.

Use these settings to make fine adjustments in the amount of each color of toner that is used for your
printed documents.

Contrasts. Contrast is the range of difference between light (highlight) and dark (shadow) colors.
To increase the overall range between light and dark colors, increase the Contrasts setting.

Highlights. Highlights are colors that are nearly white. To darken highlight colors, increase the
Highlights setting. This adjustment does not affect midtone or shadow colors.

Midtones. Midtones are colors that are halfway between white and solid density. To darken
midtone colors, increase the Midtones setting. This adjustment does not affect highlight or shadow
colors.

Shadows. Shadows are colors that are nearly solid density. To darken shadow colors, increase
the Shadows setting. This adjustment does not affect highlight or midtone colors.

Use these options to configure print modes that correspond to the various media types. To reset all
modes to factory default settings, select Restore modes.

¢ You must click Apply before your changes take effect.

Use these options to configure the product extended fuser modes to enhance print quality.

Use these system settings to configure miscellaneous print settings. These settings are not available
on the control panel.

28 You must click Apply before your changes take effect.

Save the current settings for the product to a file on your computer. Use this file to load the same settings
onto another product or to restore these settings to this product at a later time.
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Product Security

Set a password to protect the product settings. After a password is set, users will be prompted to enter
the password before they can access any of the HP ToolboxFX pages that read or write data from the
product. Setting the password on this page also sets the embedded Web server password.

Print Settings
The Print Settings folder contains links to the following main pages:

e Printing. Change the default product print settings, such as number of copies and paper
orientation.

e PCLS5. Change the PCL settings.

e PostScript. Change the PS settings.

Printing

Use these options to configure the settings for all print functions. These are the same options that are
available on the control panel. For more information, see Control-panel menus on page 9.

Bf NOTE: You must click Apply before your changes take effect.

PCL5

Use these options to configure the settings when you are using the PCL print personality.

Ef NOTE: You must click Apply before your changes take effect.

PostScript

Use this option when you are using the PostScript print personality. When the Print PostScript error
option is turned on, the PostScript error page automatically prints when PostScript errors occur.

Bf NOTE: You must click Apply before your changes take effect.

Network Settings

The network administrator can use this tab to control the network-related settings for the product when
it is connected to an IP-based network.

Shop for Supplies

This button, at the top of each page, links to a Web site where you can order replacement supplies. You
must have Internet access to use this feature.

Other Links

This section contains links that connect you to the Internet. You must have Internet access in order to
use any of these links. If you use a dial-up connection and did not connect when you first opened
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HP ToolboxFX, you must connect before you can visit these Web sites. Connecting might require that
you close HP ToolboxFX and reopen it.

Support and Troubleshooting. Connects to the support site for the product where you can search
for help with a specific problem.

Product Registration. Connects to the HP product registration Web site.
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When the product is connected to the network, the embedded Web server is automatically available.
The embedded Web server can be accessed through a standard Web browser

74 When the product is directly connected to a Windows computer, use HP ToolboxFX to view
the product status.

Use the embedded Web server to view product and network status and to manage printing functions
from your computer instead of from the product control panel.

View product control status information.

Set the type of paper loaded in each tray.

Determine the remaining life of all supplies and order new ones.

View and change tray configurations.

View and change the product settings.

View and change network configuration.

View support content that is specific to the current state of the product.

To use the embedded Web server, you must have Microsoft Internet Explorer 6 or later, Netscape
Navigator 7 or later, Safari 1.2 or later, Konqueror 3.2 or later, Firefox 1.0 or later, Mozilla 1.6 or later,
or Opera 7 or later. The embedded Web server works when the product is connected to an IP-based
network. The embedded Web server does not support IPX-based or AppleTalk printer connections. You
do not need Internet access to open and use the embedded Web server.

In a supported Web browser on your computer, type the IP address for the product in the address/
URL field. (To find the IP address, print a configuration page. See

)

B After you open the URL, you can bookmark it so that you can return to it quickly in the
future.

In a Macintosh operating system, click the Utility button.

The embedded Web server has four tabs that contain settings and information about the product:
the Status tab, the System tab, the Print tab, and the Networking tab. Click the tab that you want
to view.

See the following section for more information about each tab.
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Embedded Web server sections

ENWW

The table below describes the basic screens of the embedded Web server.

Tab or section

Description

Status tab

Provides product, status, and
configuration information.

Device Status: Shows the product status and shows the approximate life remaining
for HP supplies.

Supplies Status: Shows the approximate life remaining for HP supplies. This page
also provides supplies part numbers.

Device Configuration: Shows the information found on the product configuration
page.

Network Summary: Shows the information found on the product network summary
page.

Reports: Allows you to print the configuration page, supplies status page, network
summary, usage page, diagnostics page, color usage log, PCL font list, PCL 6 font
list, and PS font list that the product generates.

Color Usage Job Log: Shows user color print jobs on a job-by-job basis.

Event Log: Shows a list of all product events and errors.

Support button: Provides a link to the product support page. The Support button
can be password-protected; see Set password on page 69

Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected; see Set
password on page 69

Embedded Web server
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Tab or section

Description

System tab

Provides the ability to configure the
system settings from a computer.

Device Information: Allows you to name the product and assign an asset number
to it. Enter the name for the primary contact who will receive information about the
product.

Paper Setup: Allows you to change the paper-handling defaults for the product.

Print Quality: Allows you to change the print quality defaults for the product,
including calibration settings.

Print Density: Allows you to change the contrasts, highlights, midtones, and
shadows values for each supply.

Paper Types: Allows you to configure print modes that correspond to the media
types that the product accepts.

Extended Print Modes: Allows you to configure the product extended fuser modes
to enhance print quality.

System Setup: Allows you to set the Sleep Delay, Consumable User-Defined Low
percentage, and the product language.

Service: Allows you to start the cleaning procedure on the product.
Product Security: Allows you to set up a system password.

Support button: Provides a link to the product support page. The Support button
can be password-protected.

Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected.

NOTE: The System tab can be password-protected; see Set password on page 69. If
this product is on a network, always consult with the printer administrator before changing
settings on this tab.

Print tab

Provides the ability to configure
PDL-specific product settings.

Printing: Allows you to change the printing defaults for the product.
PCL 5c: Allows you to change the PCL 5c defaults for the product.
PostScript: Allows you to change the PostScript defaults for the product.

Support button: Provides a link to the product support page. The Support button
can be password-protected.

Shop for Supplies button: Provides a link to a page where you can order supplies
for the product. The Shop for Supplies button can be password-protected.

NOTE: The Networking, System, and Print tabs can be password protected; see Set
password on page 69.

Networking tab

Provides the ability to change
network settings from your
computer.

Network administrators can use this tab to control network-related settings for the product
when it is connected to an IP-based network.

NOTE: The Networking, System, and Print tabs can be password protected; see Set
password on page 69.
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Manage supplies

Supplies life

In June 2006, the International Organization for Standardization (ISO) published the ISO/IEC 19798
toner cartridge yield standard for color laser printers. HP actively participated in developing this standard
and enthusiastically supports its industry-wide use. The standard addresses a broad range of important
factors that affect yield and yield measurement, including the test document, print job size, print-quality
modes, end-of-life determination, sample size and environmental conditions. A broadly adopted
standard of this rigor represents a breakthrough in giving customers yield information that can be
accurately compared. Specific cartridge yield information can be found at: h10060.www1.hp.com/
pageyield/index.html.

Print-cartridge storage

Do not remove the print cartridge from its package until you are ready to use it.

/A CAUTION: To prevent damage to the print cartridge, do not expose it to light for more than a few
minutes.

HP policy on non-HP print cartridges

Hewlett-Packard Company cannot recommend the use of non-HP print cartridges, either new or
remanufactured.

Bf NOTE: Any damage caused by a non-HP print cartridge is not covered under the HP warranty and
service agreements.

To install a new HP print cartridge, see Change print cartridges on page 81. To recycle the used
cartridge, follow the instructions included with the new cartridge. For more information about recycling,
see Return and recycling instructions on page 142.

HP fraud hotline and Web site

Call the HP fraud hotline (1-877-219-3183, toll-free in North America) or go to www.hp.com/go/
anticounterfeit when you install an HP print cartridge and the control-panel message says the cartridge
is non-HP. HP will help determine if the cartridge is genuine and take steps to resolve the problem.

Your print cartridge might not be a genuine HP print cartridge if you notice the following:
e You are experiencing a high number of problems with the print cartridge.

e The cartridge does not look like it usually does (for example, the orange pull tab is missing, or the
packaging differs from HP packaging).

ENWW Manage supplies
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A <Supply> Low message—where <Supply> is the color cartridge—appears when a print cartridge is
nearing the end of its life. A <Supply> Very Low message appears when the print cartridge is at its
estimated end of life. To ensure optimal print quality, HP recommends replacing a print cartridge when
the <Supply> Very Low message appears. Print-quality problems can occur when using a cartridge
that is at its estimated end of life, resulting in waste of print media and toner from other cartridges.
Replacing a print cartridge when the <Supply> Very Low message appears can prevent this waste.
The supply does not need to be replaced at this point in time unless the print quality is no longer
acceptable. Once an HP supply has reached “very low’, HP’s premium Protection Warranty on that
supply has ended.

A Using the Continue setting can result in unsatisfactory print quality.

All print defects or supply failures incurred when an HP supply is used in continue at very
low mode will not be considered to be defects in materials or workmanship in the supply under the
HP Print Cartridge Warranty Statement. For warranty information, see

You can enable or disable the Continue feature at any time, and you do not have to re-enable it when
you install a new print cartridge. When the At Very Low menu is set to Continue, the product
automatically continues printing when a print cartridge reaches the recommended replacement level.

The <Supply> Very Low message appears while a print cartridge is being used in continue at very low
mode.

On the control panel, press the button.
Use the arrow buttons to select the System Setup menu, and then press the button.
Use the arrow buttons to select the At Very Low menu, and then press the button.

Use the arrow buttons to select the Black Cartridge menu or the Color Cartridge menu, and then
press the button.

Select one of the following options.

e Select the Continue option to enable the continue at very low feature.

e Select the Stop option to disable the continue at very low feature.

e Select the Prompt option to prompt the user to continue before the product will print the job.

e Select the Print Black option (Color Cartridge menu only) to force the product to print with
only the black cartridge when one of the color cartridges reaches very low status.
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Change print cartridges

When a print cartridge approaches the end of its estimated useful life, the control panel displays a
message recommending that you order a replacement. The product can continue to print using the
current print cartridge until the control panel displays a message instructing you to replace the cartridge,
unless you have selected the option to override the message by using the Replace supplies menu. For
more information about the Replace supplies menu, see System Setup menu on page 11.

= NOTE: Cartridge life remaining is used to determine if a supply is near or at estimated end of life.
Cartridge life remaining is approximate only and varies depending on types of documents printed and
other factors.

The product uses four colors and has a different print cartridge for each color: black (K), magenta (M),
cyan (C), and yellow (Y).

You can replace a print cartridge when the print quality is no longer acceptable. The control-panel
message also indicates the color of the cartridge that has reached the end of its estimated useful life
(for cartridges that are not used). Replacement instructions are provided on the label on the print
cartridge.

/A CAUTION: If toner gets on clothing, wipe it off with a dry cloth and wash the clothes in cold water. Hot
water sets toner into fabric.

B NOTE: Information about recycling used print cartridges is on the print-cartridge box.

Replace print cartridges

1. Open the front door. Make sure that the door is completely open.

2. Grasp the handle of the used print cartridge and pull out to remove.

3. Store the used print cartridge in a protective bag. Information about recycling used print cartridges
is on the print-cartridge box.
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4. Remove the new print cartridge from its protective bag.

_

Ef NOTE: Be careful not to damage the memory tag on the print cartridge.

Q

5. Grasp both sides of the print cartridge and distribute the toner by gently rocking the print cartridge.

£ 287

82 Chapter 9 Manage and maintain ENWW



6. Remove the orange protective cover from the print cartridge. Place the protective cover on the
used print cartridge to protect it during shipping.

4;

/A CAUTION: Avoid prolonged exposure to light.

CAUTION: Do not touch the green roller. Doing so can damage the cartridge.

7. Align the print cartridge with its slot and insert the print cartridge until it clicks into place.

8. Close the front door.
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Memory and font DIMMs

Product memory

The product has one dual inline memory module (DIMM) slot. Use the DIMM slot to upgrade the product
with the following items:

e  More product memory (DIMMs are available in 64, 128, and 256 MB)
e  Other DIMM-based printer languages and product options

e Support-language character sets (for example, Chinese characters or Cyrillic alphabet characters).

B NOTE: To order DIMMs, see Supplies and accessories on page 127.

You might want to increase product memory if you often print complex graphics or HP postscript level 3
emulation documents, or if you use many downloaded fonts. Additional memory also enables multiple
collated copies to print at the maximum speed.

Before ordering additional memory, see how much memory is currently installed by printing a
configuration page. See Information pages on page 66.

/A CAUTION: Static electricity can damage electronic parts. When installing DIMMs, either wear an
antistatic wrist strap, or frequently touch the surface of the DIMM antistatic package and then touch bare
metal on the product.

Install memory and font DIMMs
1. Turn the product off, and then disconnect all power and interface cables.

2. On the back of the product, open the DIMM access door.

84 Chapter 9 Manage and maintain ENWW



3.  Remove the DIMM access door.

~ IR

To replace a DIMM that is currently installed, spread the latches apart on each side of the DIMM

4,
slot, lift the DIMM up at an angle, and pull it out.
‘FUQ — H%Mtﬂjm\K |
=
JE o1y
5.  Remove the new DIMM from the antistatic package, and then locate the alignment notch on the

bottom edge of the DIMM.
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6. Holding the DIMM by the edges, align the notch on the DIMM with the bar in the DIMM slot at an
angle.

7. Push down on the DIMM until both latches engage the DIMM. When the installation is correct, the
metal contacts are not visible.

, )

B NOTE: If you have difficulty inserting the DIMM, make sure that the notch on the bottom of the
DIMM is aligned with the bar in the slot. If the DIMM still does not go in, make sure that you are
using the correct DIMM type.
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8. Reinsert the DIMM access door.

9. Close the DIMM access door.

-

m

OANANAN

\

10. Reconnect the power cable and USB or network cable, and then turn on the product.

11. After installing a memory DIMM, see Enable memory on page 88.
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Enable memory

If you installed a memory DIMM, set the printer driver to recognize the newly added memory.

Enable memory for Windows
1. On the Start menu, point to Settings, and click Printers or Printers and Faxes.
2. Select this product, and then select Properties.
3. On the Configure tab, click More.
4. In the Total Memory field, type or select the total amount of memory that is now installed.

5.  Click OK.

Check DIMM installation

Turn the product on. Check that the product is in the Ready state after it has gone through the startup
sequence. If an error message appears, do the following:

1. Print a configuration page. See Information pages on page 66.

2. Check the Installed Personalities and Options section on the configuration page and compare it
with the configuration page that you printed before the DIMM installation.

3. The DIMM might not be installed correctly. Repeat the installation procedure.
-0r-

The DIMM may be defective. Try a new DIMM.

Clean the product

During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product has
a cleaning mode that can correct and prevent these problems.

Clean the product using HP ToolboxFX
1. Open HP ToolboxFX. See Open HP ToolboxFX on page 67.

2. Click the System Settings folder, and then click the Service page.
3. Inthe area for Cleaning Mode, click the Start button to begin the cleaning process.

The product processes a single page, and then returns to the Ready state when the cleaning
process is complete.

Clean the product using the control panel
1. Press the OK button to open the menus.
2. Press the arrow buttons to highlight the Service menu, and then press the OK button.
3. Press the arrow buttons to highlight the Cleaning Mode menu, and then press the OK button.

4.  Follow the control-panel instructions to complete the process.
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Clean the product using the embedded Web server
1. Open the embedded Web server.

Click the System tab.

Click the Service menu.

Click the Start button.

o ~ 0N

Follow the product control-panel instructions to complete the process.

Firmware updates

To upgrade the product firmware, download the firmware update file from www.hp.com/go/
licp5220series_software and save the file to your network or personal computer. Refer to the product
install notes for instructions on how to install the firmware update file on the product.
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° Basic troubleshooting checklist
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° Restore factory settings

° Clear jams

e Solve image-quality problems

e Solve performance problems

° Product software problems

° Solve common Windows problems

e Solve Macintosh problems
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Basic troubleshooting checklist

If you are experiencing problems with the product, use the following checklist to identify the cause of
the problem:

e Is the product connected to power?
e Isthe product on?

e Isthe product in the Ready state?

e Are all necessary cables connected?
e  Are genuine HP supplies installed?

e  Were recently replaced print cartridges installed correctly, and was the pull tab on the cartridge
removed?

For additional information about installation and setup, see the getting started guide.

If you cannot find solutions to problems in this guide, go to www.hp.com/support/ljicp5220series.

Factors that affect product performance
Several factors affect the time it takes to print a job:
e  Maximum product speed, measured in pages per minute (ppm)
e The use of special paper (such as transparencies, heavy paper, and custom-size paper)
e  Product processing and download time
e The complexity and size of graphics
e The speed of the computer you are using

e The USB connection
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Interpret control-panel and status-alert messages

The control-panel messages indicate the current product status or situations that might require action.

Status-alert messages appear on the computer screen (in addition to control-panel messages) when
the product has certain problems. If a status-alert message is available, a \/ appears in the Status

alert column in the following table.

Control-panel messages appear temporarily and might require that you acknowledge the message by
pressing the OK button to resume printing or by pressing the cancel button %) to cancel the job. With
certain messages, the job might not finish printing or the print quality might be affected. If the message
is related to printing and the auto-continue feature is on, the product will attempt to resume printing after
the message has appeared for 10 seconds without acknowledgement.

For some messages, restarting the product might fix the problem. If a critical error persists, the product
might require service.

Control-panel message Status alert Description Recommended action
10.10.XX Supply error ‘/ e 10.1000 = black supply Check the e-label. If it is broken
memory is missing or damaged, replace the
cartridge.

e 10.1001 = cyan supply
memory is missing Verify that the cartridge is
installed in the correct location.
e 10.1002 = magenta supply
memory is missing Remove and reinstall the
cartridge and then power-cycle
° 10.1003 = yellow supply the product.
memory is missing
If the error is with a color
cartridge, try swapping it with a
different color cartridge in the
tray. If the same message
appears, then there is an engine
problem. If a different 10.10.XX
message appears, replace the
cartridge.

10.XXXX Supply error ‘/ The supply memory for one ofthe Reinstall the print cartridge.
print cartridges cannot be read or
is missing. Turn the product off and then on.

e 10.0000 = black supply If the problem is not solved,
memory error replace the cartridge.

e 10.0001 = cyan supply
memory error

° 10.0002 = magenta supply
memory error

e 10.0003 = yellow supply
memory error

ENWW Interpret control-panel and status-alert messages
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Control-panel message

Status alert Description

Recommended action

49 Error

Turn off then on

The product experienced an
internal error.

Turn the product off, wait at least
30 seconds, and then turn the
product on and wait for it to
initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

50.X Fuser error

Turn off then on

\/ The product has experienced an
error with the fuser.

Turn the product power off, wait
atleast 30 seconds, and then turn
the product power on and wait for
it to initialize.

Turn off the product, wait at least
25 minutes, and then turn on the
product.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

51.XX Error

Turn off then on

‘/ The product has experienced an
internal hardware error.

Turn the product power off, wait
atleast 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product on.

If the message persists, contact
HP support.
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Control-panel message

Status alert

Description

Recommended action

54 XX Error

Turn off then on

v

The product has experienced an
error with one of the internal
Sensors.

o 54.15=yellow

e 54.16 = magenta

e 5417 =cyan

e 54.18 = black

1. Open the door to the
cartridge tray and slide out
the cartridge tray.

2. Inspect the white
mechanism on the relevant
cartridge. It is located on the
right side of the cartridge.

3. Push the mechanism in and
out slowly. A black flag will
raise up as you push it. It
should move smoothly. If
not, push repeatedly to try to
free up any potential
obstruction.

4. Push in the cartridge tray
and close the door.

If the message persists, contact
HP support.

55.X Error

Turn off then on

The product has experienced an
internal error.

Turn the product power off, wait
atleast 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

57.X Fan error

Turn off then on

The product has experienced a
problem with its internal fan.

Turn the product power off, wait
atleast 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

59.X Error

Turn off then on

The product has experienced a
problem with one of the motors.

Turn the product power off, wait
atleast 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.
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Control-panel message

Description

Recommended action

79 Error

Turn off then on

The product has experienced an
internal firmware error.

Turn the product power off, wait
atleast 30 seconds, and then turn
the product power on and wait for
it to initialize.

If you are using a surge protector,
remove it. Plug the product
directly into the wall socket. Turn
the product power on.

If the message persists, contact
HP support.

79 Service error

Turn off then on

An incompatible DIMM is
installed.

1. Turn the product power off.

2. Install a DIMM that the
product supports. See
Service and support
on page 129 for a list of
supported DIMMs. See
Install memory and font
DIMMs on page 84 for
DIMM installation
instructions.

3. Turn the product on.

If the message persists, contact
HP support.

<Color> in wrong position

A print cartridge is installed in the
incorrect slot.

Be sure that each print cartridge
is in the correct slot. From front to
back, the print cartridges are
installed in this order: black,
cyan, magenta, yellow.

<Supply> Very Low

The System Setup menu item At
Very Low is set to Continue.

You can continue printing until
you notice a decrease in print
quality. Actual cartridge life
remaining may vary.

Once an HP supply has reached
“very low”, HP’s premium
Protection Warranty on that
supply has ended.

See System Setup menu
on page 11.

Device error

Press [OK]

An internal error occurred.

Press the OK button to resume
the job.

Front door open

The product front door is open.

Close the door.

Genuine HP supply installed

A genuine HP supply was
installed. This message will
appear briefly after the supply is
installed and then be replaced by
the message Ready.

No action necessary.
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Control-panel message

Status alert

Description

Recommended action

Incorrect supplies

v

More than one print cartridge is
installed in the incorrect slot.

Be sure that each print cartridge
is in the correct slot. From front to
back, the print cartridges are
installed in this order: black,
cyan, magenta, yellow.

Install <Color> cartridge

The cartridge is either not
installed or not correctly installed
in the product.

Install the print cartridge. See
Change print cartridges

on page 81.

Invalid driver

Press [OK]

You are using an incorrect printer
driver.

Select the correct printer driver.

Jam in <location>

The product has detected a jam.

Clear the jam from the location
indicated. The job should
continue to print. If it does not, try
reprinting the job.

If the message persists, contact
HP support.

Jam in tray <X>

Clear jam and then press [OK]

AN

The product has detected a jam.

Clear the jam from the location
indicated, and then press the
OK button.

If the message persists, contact
HP support.

Load paper

All trays are empty.

Load print media.

Load tray # <TYPE> <SIZE>

A tray is configured for the media
type and size that the print job is
requesting, but that tray is empty.

Load the correct media into the
tray, or press the OK button to
use media in a different tray.

Load tray 1 plain <SIZE>

Cleaning Mode [OK] to start

The product is ready to process
the cleaning operation.

Load Tray 1 with plain paper in
the size indicated, and then press
the OK button.

Load tray 1 <TYPE> <SIZE>

AN NEEANAN

No trays are configured for the
media type and size that the print
job is requesting.

Load the correct media into
Tray 1, or press the OK button to
use media in a different tray.

Manual duplex

Load tray X press [OK]

The first side of a manual duplex
job has printed, and the page
needs to be loaded to process the
second side.

Load the page in the indicated
tray with the side to be printed
face up, and the top of the page
away from you, and then press
the OK button.

Manual feed <TYPE> <SIZE>

Press [OK] for available media

v

The product is set for manual
feed mode.

Press the OK button to clear the
message or load the correct
media into Tray 1.

Memory is low
Press [OK]

Try again later or turn off & on

v

The product memory is almost
full.

Press the OK button to finish the
job, or press the cancel button
(%] to cancel the job.

Break the job into smaller jobs
that contain fewer pages.

For information about increasing
the product memory, see Install
memory and font DIMMs

on page 84.
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Control-panel message

Status alert

Description

Recommended action

Misprint

Press [OK]

v

Print media has been delayed as
it moves through the product.

Press the OK button to clear the
message.

Non HP supply in use

A non-HP supply is installed.

This message is temporary and
will disappear after several
seconds.

If you believe you purchased an
HP supply, go to www.hp.com/
go/anticounterfeit.

Service or repairs that are
required as a result of using non-
HP supplies are not covered
under HP warranty.

Print failure
Press [OK]
alternates with

If error repeats turn off then on

AN

The product cannot process the
page.

Press the OK button to continue
printing the job, but output might
be affected.

If the error persists, turn the
power off and then on. Resend
the print job.

Rear door open

The product rear door is open.

Close the door.

Remove shipping locks from
<color> cartridge

A print cartridge shipping lock is
installed.

Be sure that the print cartridge
shipping lock has been removed.

Remove shipping locks from
all cartridges

A print cartridge shipping lock is
installed on one or more print
cartridges.

Be sure that each print cartridge
shipping lock has been removed.

Remove shipping material
from rear door

The two shipping locks have not
been removed from the rear
roller.

Open the rear door and remove
the shipping locks.

Replace <color> cartridge

AN NI N NAN

The product can be configured to
stop when the supply level is very
low. The supply might still be able
to produce acceptable print
quality.

Replace the cartridge if print
quality is no longer acceptable.
See Change print cartridges
on page 81.

Replace supplies

AN

More than one supply item is low.

Check the supply-level gauges
on the control panel, or, if
possible, print a supplies status
page to determine which
cartridges are low. See
Information pages on page 66.

See Supplies and accessories

on page 127 for more
information.

Right door open

The product right door is open.

Close the door.

Rotate paper by 90 degrees

in tray X

ANIAN

The paper in the indicated tray is
loaded incorrectly.

Open the tray, rotate the media to
the correct orientation, and then
close the tray.
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Control-panel message Status alert Description Recommended action

Unexpected size in tray # ‘/ The product has detected print Load the correct media into the
media in the tray that does not tray, or configure the tray for the

Load <size> press [OK] match the configuration for the size that you have loaded. See
tray. Load trays on page 46.

A used print cartridge was No action necessary.
detected and accepted.

Used <color> Cartridge in use

The product has detected aused Press the OK button to continue.
print cartridge that was installed.

Used <color> installed

To accept press [OK]

The product has detected Press the OK button to continue.
multiple used print cartridges that
were installed.

Used cartridges installed

To accept press [OK]

Used print cartridges are No action necessary.
installed.

Used supplies in use

ANIER NN SR

Used supply installed A used print cartridge is installed. Press the OK button to continue.

To accept press [OK]
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Restore factory settings
1. On the control panel, press the OK button.
2. Use the arrow buttons to select the Service menu, and then press the OK button.
3. Use the arrow buttons to select the Restore Defaults menu, and then press the OK button.
4

Press the OK button to restore the factory default settings. Press the cancel button ¥ to exit the
menu without restoring the factory default settings.
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Clear jams

Common causes of jams

ENWW

Common causes of jams'

Cause

Solution

The paper length and width guides are not adjusted correctly.

Adjust the guides so they are against the paper stack.

The media does not meet specifications.

Use only media that meets HP specifications. See Paper and
print media on page 39.

You are using media that has already passed through a printer
or copier.

Do not use media that has been previously printed on or
copied.

An input tray is loaded incorrectly.

Remove any excess media from the input tray. Make sure that
the stack is below the maximum stack height mark in the tray.
See Load trays on page 46.

The media is skewed.

The input-tray guides are not adjusted correctly. Adjust them
so they hold the stack firmly in place without bending it.

The media is binding or sticking together.

Remove the media, flex it, rotate it 180 degrees, or flip it over.
Reload the media into the input tray.

NOTE: Do not fan paper. Fanning can create static
electricity, which can cause paper to stick together.

The media is removed before it settles into the output bin.

Wait until the page completely settles in the output bin before
removing it.

The paper is too heavy.

Do not use paper that exceeds the supported weights for the
input tray. See Supported paper types and fray capacity
on page 43.

Do not use paper that exceeds the supported weight for
automatic duplex printing. See Supported paper sizes for
duplex printing on page 44.

The media is in poor condition.

Replace the media.

The internal rollers from the tray are not picking up the media.

Remove the top sheet of media. If the media is too heavy, it
might not be picked from the tray. See Supported paper types
and tray capacity on page 43.

The media has rough or jagged edges.

Replace the media.

The media is perforated or embossed.

Perforated or embossed media does not separate easily. Load
sheets one at a time.

Paper was not stored correctly.

Replace the paper in the trays. Paper should be stored in the
original packaging in a controlled environment.

T If the product continues to jam, contact HP Customer Support or your authorized HP service provider.
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Jam locations

Use this illustration to identify locations of jams. In addition, instructions appear on the control panel to
direct you to the location of jammed paper and how to clear it.

B NOTE: Internal areas of the product that might need to be opened to clear jams have green handles
or green labels.

Figure 10-1 Jam locations

y 4
-8

1 Output-bin area

2 Duplexing area

3 Tray 1 area

4 Optional 500-sheet paper and heavy media tray (Tray 3)
5 Tray 2 pickup area

6 Fuser area

Change Jam Recovery setting

When the Jam Recovery feature is turned on, the product reprints any pages that are damaged during
ajam.

Use the embedded Web server to turn on the Jam Recovery feature.
1. Open the EWS.
2. Click the System tab, and then click the System Setup page.

3. Inthe Jam Recovery drop-down list, select the On option.
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Clear jams in the right door

/A CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before handling
it.

1. Open the right door.

2. If paper is visible entering the bottom of the fuser, gently pull downward to remove it.

/A CAUTION: Do not touch the rollers. Contaminates can affect print quality.

3. If paper is jammed inside the right door, gently pull the paper to remove it.
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4. If jammed paper is present in the duplex path, gently pull the paper straight out to remove it.

6. Paper could be jammed inside the fuser where it would not be visible. Open the fuser to check for
jammed paper inside.
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/A CAUTION: The fuser can be hot while the product is in use. Wait for the fuser to cool before
handling it.

a. Lift the green tab on the left side of the fuser to open the fuser jam-access door. If paper is
jammed inside the fuser, gently pull it straight out to remove it. If the paper tears, remove all
paper fragments.

/A CAUTION: Even if the body of the fuser has cooled, the rollers that are inside could still be
hot. Do not touch the fuser rollers until they have cooled.

b. If paper is not visible in the fuser, paper might be jammed underneath the fuser. To remove
the fuser, grasp the fuser handles, lift up slightly, and pull straight out.
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c. If jammed paper is present in the fuser cavity, gently pull the paper straight out to remove it.

7. Close the right door.
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Clear jams in the output bin area

1. If paper is visible from the output bin, grasp the leading edge and remove it.

2. If jammed paper is visible in the duplex output area, gently pull it to remove it.

Clear jams in Tray 1

1. If jammed paper is visible in Tray 1, clear the jam by gently pulling the paper straight out. Press
the OK button to clear the message.
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2. If you cannot remove the paper, or if no jammed paper is visible in Tray 1, close Tray 1 and open
the right door.

3. If paper is visible inside the right door, gently pull the trailing edge to remove it.

4.  Gently pull the paper out of the pick up area.
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5. Close the right door.

Clear jams in Tray 2

/A CAUTION: Opening a tray when paper is jammed can cause the paper to tear and leave pieces of
paper in the tray, which might cause another jam. Be sure to clear jams before opening the tray.

1. Open Tray 2 and make sure that the paper is stacked correctly. Remove any jammed or damaged
sheets of paper.

2. Close the tray.
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Clear jams in the optional 500-sheet paper and heavy media tray (Tray 3)

1. Open Tray 3 and make sure that the paper is stacked correctly. Remove any damaged or jammed
sheets of paper.

2. Close Tray 3.
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Clear jams in the lower right door (Tray 3)

1. Open the lower right door.

2. If paper is visible, gently pull the jammed paper up or down to remove it.

3. Close the lower right door.
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Solve image-quality problems

Occasionally, you might encounter problems with print quality. The information in the following sections
helps you identify and resolve these issues.

Identify and correct print defects

Use the checklist and print-quality issues charts in this section to solve print-quality problems.

Print-quality checklist

General print-quality problems can be solved by using the following checklist:

1.

2,

Make sure the shipping locks have been removed from the transfer roller inside the rear door.

Make sure that the paper or print media that you are using meets specifications. Generally,
smoother paper provides better results.

If you are using a special print media such as labels, transparencies, glossy, or letterhead, ensure
that you have printed by type.

Print a configuration page and supplies status page. See Information pages on page 66.

° Check the supplies status page to see if any supplies are low or at estimated end of life. No
information is provided for used print cartridges

° If the pages do not print correctly, the problem is with the hardware. Contact HP Customer
Care. See Service and support on page 129 or the flyer that came in the box.

Print a Demo page from HP ToolboxFX. If the page prints, the problem is with the printer driver.

Try printing from a different program. If the page prints correctly, the problem is with the program
from which you were printing.

Restart the computer and the product and try printing again. If the problem is not resolved, choose
one of these options:

° If the problem is affecting all printed pages, see General print quality issues on page 113.

° If the problem is affecting only pages printed in color, see Solve issues with color
documents on page 117.
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General print quality issues

The following examples depict Letter-size paper that has passed through the product short-edge first.
These examples illustrate problems that would affect all of the pages that you print, whether you print
in color or in black only. The topics that follow list the typical cause and solution for each of these

examples.

Problem

Cause

Solution

Print is light or faded.

Aa ' Cc
Aa ' Cc
Aa ' Cc
Aa ' Cc
Aa ' Cc

The media might not meet
HP specifications.

Use media that meets HP specifications.

One or more print cartridges might be
defective.

Print the Supplies status page to check
the remaining life. See Information pages

on page 66.

Replace any low print cartridges. See
Change print cartridges on page 81.

The product is set to override the
<Supply> Very Low message and to
continue printing.

Replace any low print cartridges. See
Change print cartridges on page 81.

The print density settings may have been
changed.

Set the print density setting to 0.

The product may need to be calibrated.

Run a calibration. See Calibrate the
product on page 120.

Toner specks appear.

' AaBbCc
AgBbCC
AaBbCc.
AaBbCc
AaBbCc.

The media might not meet
HP specifications.

Use media that meets HP specifications.

The paper path might need cleaning.

Clean the paper path. See Clean the
product on page 88.

One or more of the cartridges may be
leaking.

Try to verify the color of the toner specks
and check the cartridge for leaks.

The cartridge waste tank may be
overfilled.

Check for error code 10.98.XX in the
eventlog. See Eventlog on page 68. The
XX portion of the code identifies the
cartridge (00 is black, 01 is cyan, 02 is
magenta, 03 is yellow). If the error was
logged, replace the affected cartridge.

Dropouts appear.

AaBbCc
AaBbCc
AasbCc
AaRDCc
AnBYCc

A single sheet of print media might be
defective.

Try reprinting the job.

The moisture content of the paper is
uneven or the paper has moist spots on
its surface.

Try different paper, such as high-quality
paper that is intended for color laser
printers.

The paper lot is flawed. The
manufacturing processes can cause
some areas to reject toner.

Try different paper, such as high-quality
paper that is intended for color laser
printers.
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Problem

Cause

Solution

Vertical streaks or bands appear on the
page.

Az Bh(C ¢
Az Bb(C ¢
Az |Bb(C ¢
Az Bh(C ¢
Az Bb(Z ¢

One or more print cartridges might be
defective.

Print the Supplies status page to check
the remaining life. See Information pages
on page 66.

Use HP ToolboxFX to troubleshoot the
problem.

Replace any low print cartridges. See
Change print cartridges on page 81.

The product is set to override the
<Supply> Very Low message and to
continue printing.

Replace any low print cartridges. See
Change print cartridges on page 81.

The amount of background toner
shading becomes unacceptable.

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

Very dry (low humidity) conditions can
increase the amount of background
shading.

Check the product environment.

One or more print cartridges might be
defective.

Replace any low print cartridges. See
Change print cartridges on page 81.

The product is set to override the
<Supply> Very Low message and to
continue printing.

Replace any low print cartridges. See
Change print cartridges on page 81.

Smooth media shows more background
than plain media

Consider using rougher media.

Toner smears appear on the media.

AaBbCc
AaBQLcC
AaBk,Cc
AaBk,Cc
AaBbCc

The media might not meet
HP specifications.

Use media that meets HP specifications.

If toner smears appear on the leading
edge of the paper, the media guides are
dirty, or debris has accumulated in the
print path.

Clean the media guides.

Clean the paper path. See Clean the
product on page 88.

The toner smears easily when touched.

AaBbCc
f S
A

AaBbCc
AaBbCc

The product is not set to print on the type
of media on which you want to print.

In the printer driver, select the Paper tab
and set Type is to match the type of
media on which you are printing. Print
speed might be slower if you are using
heavy paper.

The media might not meet
HP specifications.

Use media that meets HP specifications.

The paper path might need cleaning.

Clean the paper path. See Clean the
product on page 88.

114 Chapter 10 Solve problems

ENWW



ENWW

Problem

Cause

Solution

Marks repeatedly appear at even
intervals on the printed side of the page.

AcBbCc’[™
AaBpbCc,
AaBbCc
AaBbCc,
AaBbCc

The product is not set to print on the type
of media on which you want to print.

In the printer driver, select the Paper tab
and set Type is to match the type of
paper on which you are printing. Print
speed might be slower if you are using
heavy paper.

Internal parts might have toner on them.

The problem typically corrects itself after
a few more pages.

The paper path might need cleaning.

Clean the paper path. See Clean the
product on page 88.

The fuser might be damaged or dirty.

To determine if the fuser has a problem,
open the HP ToolboxFX and print the
print-quality diagnostics page. See Open
HP ToolboxFX on page 67.

Contact HP Customer Care. See Service
and support on page 129 or the support
flyer that came in the box.

A print cartridge may have a problem.

To determine which cartridge has a

problem, open the HP ToolboxFX and
print the print-quality diagnostics page.
See Open HP ToolboxFX on page 67.

Marks repeatedly appear at even
intervals on the unprinted side of the

page.

Internal parts might have toner on them.

The problem typically corrects itself after
a few more pages.

The paper path might need cleaning.

Clean the paper path. See Clean the
product on page 88.

The fuser might be damaged or dirty.

To determine if the fuser has a problem,
open the HP ToolboxFX and print the
print-quality diagnostics page. See Open
HP ToolboxFX on page 67.

Contact HP Customer Care. See Service
and support on page 129 or the support
flyer that came in the box.

The printed page contains misformed
characters.

AaBbCc
AacBbCc
AaBloCc
AaBbCc
AaBbCc
AaBbCc

The media might not meet
HP specifications.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.

If characters are incorrectly formed so
that they produce a wavy effect, you may
need to calibrate the product or the laser
scanner might need service.

Verify that the problem also occurs on
the configuration page. If so, contact
HP Customer Care. See Service and
support on page 129 or the support flyer
that came in the box.
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Problem

Cause

Solution

The printed page is curled or wavy.

The product is not set to print on the type

of media on which you want to print.

In the printer driver, select the Paper tab
and set Type is to match the type of
paper on which you are printing. Print
speed might be slower if you are using
heavy paper.

The Service menu item Less Paper
Curl is set to Off.

Use the control-panel menus to change
the setting. See Control-panel menus

on page 9.

The media might not meet
HP specifications.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.

Both high temperature and humidity can

cause paper curl.

Check the product environment. Adjust
curl modes from the control panel,
HP ToolboxFX, or the EWS.

Text or graphics are skewed on the
printed page.

The media might be loaded incorrectly.

Make sure that the paper or other print
media is loaded correctly and that the
media guides are not too tight or too
loose against the stack. See Load frays
on page 46.

The media might not meet
HP specifications.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.

The printed page contains wrinkles or
creases.

The media might be loaded incorrectly.

Verify that the media is loaded correctly
and that the media guides are not too
tight or too loose against the stack. See
Load trays on page 46.

Turn over the stack of paper in the input
tray, or try rotating the paper 180° in the
input tray.

The media might not meet
HP specifications.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.

Toner appears around the printed
characters.

The media might be loaded incorrectly.

Turn over the stack of paper in the tray.

If large amounts of toner have scattered
around the characters, the paper might
have high resistivity.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.
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Problem

Cause

Solution

An image that appears at the top of the
page (in solid black) repeats farther
down the page (in a gray field).

AaBbCc

Software settings might affect image
printing.

In your software program, change the
tone (darkness) of the field in which the
repeated image appears.

In your software program, rotate the
whole page 180° to print the lighter
image first.

The order of images printed might affect
printing.

Change the order in which the images
are printed. For example, have the lighter
image at the top of the page, and the
darker image farther down the page.

A power surge might have affected the
product.

If the defect occurs later in a print job,
turn the product off for 10 minutes, and
then turn on the product to restart the
print job.

Use non-glossy media to help reduce the
severity of the defect

This section describes issues that can occur when you print in color.

Problem

Cause

Solution

Only black is printing when the document
should be printing in color.

AaBbCc
AaBbCc
AaBbCc
AaBbCc
AaBbCc

Color mode is not selected in your
program or printer driver or the allow
color setting is off.

Select color mode instead of grayscale
mode or turn on the allow color setting.

The correct printer driver might not be
selected in the program.

Select the correct printer driver.

The product might not be correctly
configured.

Print a configuration page (see
Information pages on page 66). If no
color appears on the configuration page,
contact HP Customer Care. See Service
and support on page 129 or the support
flyer that came in the box.

The color supply has reached estimated
[lend of life and the <Supply> Very
Low menu setting is set to Print Black.

Replace the color supply.
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Problem

Cause

Solution

One or more colors are not printing, or
are inaccurate.

AaBbCg¢g
AaBb¢Zc
AaBbCc
AcBbCcC

AaBobCc

Sealing tape might be on the print
cartridges.

Verify that the sealing tape has been
completely removed from the print
cartridges.

The media might not meet
HP specifications.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.

The product might be operating in
excessively humid conditions.

Verify that the product environment is
within humidity specifications.

One or more print cartridges might be
defective.

Replace any low print cartridges. See
Change print cartridges on page 81.

The product is set to override the
<Supply> Very Low message and to
continue printing.

Replace any low print cartridges. See
Change print cartridges on page 81.

One or more of the cartridges may not
have been engaged properly by the print
engine.

Remove and reinstall the cartridges.

A color is printing inconsistently after you
load a new print cartridge.

AaBbCc

AaBbCc

Another print cartridge might be
defective.

Remove the print cartridge for the color
that is printing inconsistently and reinstall
it.

The product is set to override the
<Supply> Very Low message and to
continue printing.

Replace any low print cartridges. See
Change print cartridges on page 81.

The colors on the printed page do not
match the colors as they appear on the
screen.

The colors on your computer monitor
might differ from the product output.

See Match colors on page 60

If extremely light colors or extremely dark
colors on screen are not printing, your
software program might interpret
extremely light colors as white or
extremely dark colors as black.

If possible, avoid using extremely light or
extremely dark colors.

The media might not meet
HP specifications.

Use a different paper, such as high-
quality paper that is intended for color
laser printers.

The finish on the printed color page is
inconsistent.

AaBbCe
AaBbCc
AaBbCc
AaBbCc
AaBbCc

The media might be too rough.

Use a smooth paper or print media, such
as a high-quality paper that is made for

color laser printers. Generally, smoother
media produces better results.
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Use HP ToolboxFX to troubleshoot print-quality problems

Bf NOTE: Before proceeding, print a Supplies status page to see the approximate number of pages

ENWW

remaining for each print cartridge. See Information pages on page 66.

From the HP ToolboxFX software you can print a page that helps identify whether a specific print
cartridge is causing the problem, or if the problem is with the product itself. The print-quality
troubleshooting page prints five bands of color, which are divided into four overlapping sections. By
examining each section, you can isolate the problem to a particular cartridge.

L1 2, © (4

Section Print-cartridge
1 Yellow

2 Cyan

3 Black

4 Magenta

This page helps identify four general issues:

e Streaks in only one color: This is most likely a cartridge issue. Remove the cartridge and look
for debris on it. If no debris is found and the defect continues after the cartridge is reinstalled,
replace the cartridge.

o Streaks in all colors (in same location): Clean the printer and call for service if the problem
continues.

e Repeating defect in multiple colors:

Repeating dot in multiple colors: If the dot repeats at roughly 57 or 58 mm, run a cleaning page to
clean fuser and run several white pages of paper to clean the roller. If defect does not repeat at 57
or 58 mm, replace the cartridge of the color of the dot.

Repeating band in multiple colors: Contact HP Support.

e Single dot or Single band in one color: Print three or four additional troubleshooting pages. If
the band or dot is only in one color on most of the pages, replace the cartridge of that color. If the
band or dot moves to a different color, contact HP Support.

For more troubleshooting information, try the following:

e See Solve image-quality problems on page 112 in this guide.

° Go to www.hp.com/support/licp5220series.

e Contact HP Customer Care. See Service and support on page 129.
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Print the print-quality troubleshooting page
1. Open HP ToolboxFX. See Open HP ToolboxFX on page 67.

2. Click the Help folder, and then click the Troubleshooting page.

3. Click the Print button, and then follow the directions on the printed pages.

Optimize and improve print quality

Always make sure that the Type is setting in the printer driver matches the type of paper that you are
using.

Use the print-quality settings in the printer driver to prevent print-quality problems.

Use the Device Settings area in HP ToolboxFX to adjust settings that affect print quality. See Open
HP ToolboxFX on page 67.

Also use HP ToolboxFX to help troubleshoot print-quality problems. See Use HP ToolboxFX to
troubleshoot print-quality problems on page 119.

Calibrate the product

If you experience any print-quality problems, calibrate the product.

Calibrate the product using HP ToolboxFX
1. Open HP ToolboxFX. See Open HP ToolboxFX on page 67.

2. Click the Device Settings folder, and then click the Print Quality page.
3. In the area for Color Calibration, select the Calibrate Now check box.
4,

Click Apply to calibrate the product immediately.

Calibrate the product from the control panel

1. On the control panel, press the OK button.

2. Use the arrow buttons to select the System Setup menu, and then press the OK button.

3. Use the arrow buttons to select the Print Quality menu, and then press the OK button.
4. Use the arrow buttons to select the Color Calibration menu, and then press the OK button.
5

Use the arrow buttons to select the Calibrate Now option, and then press the OK button to calibrate
the product.
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Solve performance problems

Problem

Cause

Solution

Pages print but are totally blank.

The sealing tape might still be in the print
cartridges.

Verify that the sealing tape has been
completely removed from the print
cartridges.

The document might contain blank
pages.

Check the document that you are printing
to see if content appears on all of the
pages.

The product might be malfunctioning.

To check the product, print a
configuration page.

Pages print very slowly.

Heavier media types can slow the print
job.

Print on a different type of media.

Complex pages can print slowly.

Proper fusing may require a slower print
speed to ensure the best print quality.

Paper type not set correctly.

Select the type to match the paper.

Pages did not print.

The product might not be pulling media
correctly.

Make sure paper is loaded in the tray
correctly.

If the problem persists, you might need
to replace the pickup rollers and the
separation pad. See Service and support
on page 129.

The media is jamming in the product.

Clear the jam. See Clear jams
on page 101.

If jams continue, try using a new ream of
paper.

The USB cable might be defective or
incorrectly connected.

° Disconnect the USB cable at both
ends and reconnect it.

e  Try printing a job that has printed in
the past.

e Try using a different USB cable.

Other devices are running on your
computer.

The product might not share a USB port.
If you have an external hard drive or
network switchbox that is connected to
the same port as the product, the other
device might be interfering. To connect
and use the product, you must
disconnect the other device or you must
use two USB ports on the computer.
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Product software problems

Problem

Solution

A printer driver for the product is not visible in the Printer folder

Reinstall the product software.

NOTE: Close any applications that are running. To
close an application that has an icon in the system tray,
right-click the icon, and select Close or Disable.

Try plugging the USB cable into a different USB port on
the computer.

An error message was displayed during the software
installation

Reinstall the product software.

NOTE: Close any applications that are running. To
close an application that has an icon in the task bar, right-
click the icon, and select Close or Disable.

Check the amount of free space on the drive where you
are installing the product software. If necessary, free up
as much space as you can, and reinstall the product
software.

If necessary, run the Disk Defragmenter, and reinstall the
product software.

The product is in Ready mode, but nothing prints

Print a Configuration page, and verify the product
functionality.

Verify that all of the cables are correctly seated and within
specifications. This includes the USB and power cables.
Try a new cable.
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Solve common Windows problems
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Error message:
"General Protection FaultException OE"
"Spool32"

"lllegal Operation"

Cause

Solution

Close all software programs, restart Windows, and try again.

Select a different printer driver. If the product PCL 6 printer
driver is selected, switch to the PCL 5 or HP postscript level 3
emulation printer driver, which can be done from a software
program.

Delete all temp files from the Temp subdirectory. Determine
the name of the directory by opening the AUTOEXEC.BAT file
and looking for the statement "Set Temp =". The name after
this statement is the Temp directory. It is usually C:\TEMP by
default, but can be redefined.

See the Microsoft Windows documentation that came with the
computer for more information about Windows error
messages.

Solve common Windows problems
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Solve Macintosh problems

Solve problems with Mac OS X

B NOTE:

If you are installing the product using a USB connection, do not connect the USB cable to the

product and the computer before you install the software. Connecting the USB cable will cause the Mac
OS X to automatically install the product, but the installation will be faulty. You must then uninstall the
product, disconnect the USB cable, reinstall the software from the product CD-ROM, and reconnect the

USB cable when the software prompts you.

The printer driver is not listed in the Print Center or Printer Setup Ultility.

Cause

Solution

The product software might not have been installed or was installed
incorrectly.

Make sure that the product PPD file is in the following hard-drive
folder: LIBRARY/PRINTERS/PPDS/CONTENTS/RESOURCES/
<LANG>.LPROJ where <lang> is the two-letter language code for the
language that you are using. If necessary, reinstall the software. See
the getting started guide for instructions.

The PPD file is corrupt.

Delete the PPD file from the following hard-drive folder: LIBRARY/
PRINTERS/PPDS/CONTENTS/RESOURCES/<LANG>.LPROJ where
<lang> is the two-letter language code for the language that you are
using. Reinstall the software. See the getting started guide for
instructions.

The product name, IP address, or Bonjour printer name does not appear in the printer list in the Print & Fax Center or Printer Setup

Utility.

Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the Ready light is on. If you are connecting through a USB or
Ethernet hub, try connecting directly to the computer or use a different
port.

The wrong connection type might be selected.

Make sure that USB, IP Printing, or Bonjour is selected, depending
on the type of connection being used.

The wrong product name, IP address, or Bonjour host name is being
used.

Print a network summary page (see Information pages on page 66).
Verify that the product name, IP address, or Bonjour host name on
the network summary page matches the product name, IP address,
or Bonjour host name in the Print Center, Printer Setup Utility, or Print
& Fax list.

The interface cable might be defective or of poor quality.

Replace the interface cable with a high-quality cable.

The printer driver does not automatically set up your selected product in the Print Center or Printer Setup Utility.

Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the Ready light is on. If you are connecting through a USB hub,
try connecting directly to the computer or use a different port.
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The printer driver does not automatically set up your selected product in the Print Center or Printer Setup Utility.

Cause

Solution

The product software might not have been installed or was installed
incorrectly.

Make sure that the product PPD file is in the following hard-drive
folder: LIBRARY/PRINTERS/PPDS/CONTENTS/RESOURCES/
<LANG>.LPROJ where <lang> is the two-letter language code for the
language that you are using. If necessary, reinstall the software. See
the getting started guide for instructions.

The PPD file is corrupt.

Delete the PPD file from the following hard-drive folder: LIBRARY/
PRINTERS/PPDS/CONTENTS/RESOURCES/<LANG>.LPROJ where
<lang> is the two-letter language code for the language that you are
using. Reinstall the software. See the getting started guide for
instructions.

The interface cable might be defective or of poor quality.

Replace the interface cable with a high-quality cable.

A print job was not sent to the product that you wanted.

Cause

Solution

The print queue might be stopped.

Restart the print queue. Open Print Monitor and select Start Jobs.

The wrong product name, IP address, or Bonjour printer name is
being used.

Print a network summary page (see Information pages on page 66).
Verify that the product name, IP address, or Bonjour printer name on
the network summary page matches the product name, IP address,
or Bonjour printer name in the Print Center or Printer Setup Utility.

An EPS file prints with incorrect fonts.

Cause

Solution

This problem occurs with some programs.

e  Try downloading the fonts that are contained in the EPS file to
the product before printing.

e Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.

Cause

Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.
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When connected with a USB cable, the product does not appear in the Print Center or Printer Setup Utility after the driver is selected.

Cause

Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting

Verify that the product is not plugged into any Macintosh USB
keyboards.

Verify that your Macintosh operating system is Mac OS X v10.3
or later.

Hardware troubleshooting

Check that the product is turned on.
Verify that the USB cable is connected correctly.

Verify that the product is plugged directly to the Macintosh
computer, not a USB keyboard port.

Check that you are using the appropriate high-speed USB cable.

Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

Verify at the product control panel that the USB Speed setting
is set to the Full option.

Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.

NOTE: The iMac keyboard is a nonpowered USB hub.
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A Supplies and accessories

° Order parts, accessories, and supplies

° Part numbers
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Order parts, accessories, and supplies

Order supplies and paper www.hp.com/go/suresupply

Order genuine HP parts or accessories www.hp.com/buy/parts

Order through service or support providers Contact an HP-authorized service or support provider.
Order using HP software HP ToolboxFX on page 67

Embedded Web server on page 76

Part numbers

Table A-1 Supplies and accessories

Part Part number Typelsize
Print cartridges CE740A Black print cartridge with HP ColorSphere toner
For information CE741A Cyan print cartridge with HP ColorSphere toner
about the yield for
the cartridges, see ~ CE742A Yellow print cartridge with HP ColorSphere toner
www.hp.com/go/ . . .
hagevield. Actual CE743A Magenta print cartridge with HP ColorSphere toner
yield depends on
specific use.
Optional 500-page CEB860A Optional 500-sheet input tray.
tray (Tray 3)
Cables C6518A USB 2.0 printer cable (2-meter [6.5-foot] standard)
Memory CB421A 64MB DDR2 144-pin SDRAM DIMM

CB422A 128MB DDR2 144-pin SDRAM DIMM

CB423A 256MB DDR2 144-pin SDRAM DIMM
Reference materials 5851-1468 HP LaserJet Printer Family Print Media Specification Guide (see

www.hp.com/support/ljpaperguide)
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B Service and support

° Hewlett-Packard limited warranty statement

° Print cartridge limited warranty statement

° End User License Agreement

° Customer self-repair warranty service

° Customer support

° Repack the product

° Service information form
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HP PRODUCT DURATION OF LIMITED WARRANTY

HP Color LaserJet CP5220 Series printers One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects
in materials and workmanship after the date of purchase, for the period specified above. If HP receives
notice of such defects during the warranty period, HP will, at its option, either repair or replace products
which prove to be defective. Replacement products may be either new or equivalent in performance to
new.

HP warrants to you that HP software will not fail to execute its programming instructions after the date
of purchase, for the period specified above, due to defects in material and workmanship when properly
installed and used. If HP receives notice of such defects during the warranty period, HP will replace
software which does not execute its programming instructions due to such defects.

HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable,
within a reasonable time, to repair or replace any product to a condition as warranted, you will be entitled
to a refund of the purchase price upon prompt return of the product.

HP products may contain remanufactured parts equivalent to new in performance or may have been
subject to incidental use.

Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration,
(b) software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse,
(d) operation outside of the published environmental specifications for the product, or (e) improper site
preparation or maintenance.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND
NO OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
Some countries/regions, states or provinces do not allow limitations on the duration of an implied
warranty, so the above limitation or exclusion might not apply to you. This warranty gives you specific
legal rights and you might also have other rights that vary from country/region to country/region, state
to state, or province to province.

HP's limited warranty is valid in any country/region or locality where HP has a support presence for this
product and where HP has marketed this product. The level of warranty service you receive may vary
according to local standards. HP will not alter form, fit or function of the product to make it operate in a
country/region for which it was never intended to function for legal or regulatory reasons.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT
ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT
WILL HP OR ITS SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL,
INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE,
WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE. Some countries/regions, states or
provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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This HP product is warranted to be free from defects in materials and workmanship.

This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the printer product or (c) exhibit wear
from ordinary use.

To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.

THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

ENWW Print cartridge limited warranty statement 131



PLEASE READ CAREFULLY BEFORE USING THIS SOFTWARE PRODUCT: This End-User License
Agreement (“EULA”) is a contract between (a) you (either an individual or the entity you represent) and
(b) Hewlett-Packard Company (“HP”) that governs your use of the software product (“Software”). This
EULA does not apply if there is a separate license agreement between you and HP or its suppliers for
the Software, including a license agreement in online documentation. The term “Software” may include
(i) associated media, (ii) a user guide and other printed materials, and (iii) “online” or electronic
documentation (collectively “User Documentation”).

RIGHTS IN THE SOFTWARE ARE OFFERED ONLY ON THE CONDITION THAT YOU AGREE TO
ALL TERMS AND CONDITIONS OF THIS EULA. BY INSTALLING, COPYING, DOWNLOADING, OR
OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THIS EULA. IF YOU DO
NOT ACCEPT THIS EULA, DO NOT INSTALL, DOWNLOAD, OR OTHERWISE USE THE
SOFTWARE. IF YOU PURCHASED THE SOFTWARE BUT DO NOT AGREE TO THIS EULA, PLEASE
RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE WITHIN FOURTEEN DAYS FOR A
REFUND OF THE PURCHASE PRICE; IF THE SOFTWARE IS INSTALLED ON OR MADE
AVAILABLE WITH ANOTHER HP PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED
PRODUCT.

1. THIRD PARTY SOFTWARE. The Software may include, in addition to HP proprietary software
(“HP Software”), software under licenses from third parties (“Third Party Software” and “Third Party
License”). Any Third Party Software is licensed to you subject to the terms and conditions of the
corresponding Third Party License. Generally, the Third Party License is located in a file such as
license.txt; you should contact HP support if you cannot find any Third Party License. If the Third Party
Licenses include licenses that provide for the availability of source code (such as the GNU General
Public License) and the corresponding source code is not included with the Software, then check the
product support pages of HP’s website (hp.com) to learn how to obtain such source code.

2. LICENSE RIGHTS. You will have the following rights provided you comply with all terms and
conditions of this EULA:

a. Use. HP grants you a license to Use one copy of the HP Software. “Use” means installing, copying,
storing, loading, executing, displaying, or otherwise using the HP Software. You may not modify the
HP Software or disable any licensing or control feature of the HP Software. If this Software is provided
by HP for Use with an imaging or printing product (for example, if the Software is a printer driver,
firmware, or add-on), the HP Software may only be used with such product (“‘HP Product”). Additional
restrictions on Use may appear in the User Documentation. You may not separate component parts of
the HP Software for Use. You do not have the right to distribute the HP Software.

b. Copying. Your right to copy means you may make archival or back-up copies of the HP Software,
provided each copy contains all the original HP Software’s proprietary notices and is used only for back-
up purposes.

3. UPGRADES. To Use HP Software provided by HP as an upgrade, update, or supplement (collectively
“Upgrade”), you must first be licensed for the original HP Software identified by HP as eligible for the
Upgrade. To the extent the Upgrade supersedes the original HP Software, you may no longer use such
HP Software. This EULA applies to each Upgrade unless HP provides other terms with the Upgrade. In
case of a conflict between this EULA and such other terms, the other terms will prevail.

4. TRANSFER.

a. Third Party Transfer. The initial end user of the HP Software may make a one-time transfer of the
HP Software to another end user. Any transfer will include all component parts, media, User
Documentation, this EULA, and if applicable, the Certificate of Authenticity. The transfer may not be an
indirect transfer, such as a consignment. Prior to the transfer, the end user receiving the transferred
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Software will agree to this EULA. Upon transfer of the HP Software, your license is automatically
terminated.

b. Restrictions. You may not rent, lease or lend the HP Software or Use the HP Software for commercial
timesharing or bureau use. You may not sublicense, assign or otherwise transfer the HP Software except
as expressly provided in this EULA.

5. PROPRIETARY RIGHTS. All intellectual property rights in the Software and User Documentation are
owned by HP or its suppliers and are protected by law, including applicable copyright, trade secret,
patent, and trademark laws. You will not remove any product identification, copyright notice, or
proprietary restriction from the Software.

6. LIMITATION ON REVERSE ENGINEERING. You may not reverse engineer, decompile, or
disassemble the HP Software, except and only to the extent that the right to do so is allowed under
applicable law.

7. CONSENT TO USE OF DATA. HP and its affiliates may collect and use technical information you
provide in relation to (i) your Use of the Software or the HP Product, or (ii) the provision of support
services related to the Software or the HP Product. All such information will be subject to HP’s privacy
policy. HP will not use such information in a form that personally identifies you except to the extent
necessary to enhance your Use or provide support services.

8. LIMITATION OF LIABILITY. Notwithstanding any damages that you might incur, the entire liability of
HP and its suppliers under this EULA and your exclusive remedy under this EULA will be limited to the
greater of the amount actually paid by you for the Product or U.S. $5.00. TO THE MAXIMUM EXTENT
PERMITTED BY APPLICABLE LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES (INCLUDING
DAMAGES FOR LOST PROFITS, LOST DATA, BUSINESS INTERRUPTION, PERSONAL INJURY,
OR LOSS OF PRIVACY) RELATED IN ANY WAY TO THE USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF HP OR ANY SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES AND EVEN IF THE ABOVE REMEDY FAILS OF ITS ESSENTIAL PURPOSE. Some states
or other jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

9. U.S. GOVERNMENT CUSTOMERS. If you are a U.S. Government entity, then consistent with FAR
12.211 and FAR 12.212, Commercial Computer Software, Computer Software Documentation, and
Technical Data for Commercial Items are licensed under the applicable HP commercial license
agreement.

10. COMPLIANCE WITH EXPORT LAWS. You will comply with all laws, rules, and regulations (i)
applicable to the export or import of the Software, or (ii) restricting the Use of the Software, including
any restrictions on nuclear, chemical, or biological weapons proliferation.

11. RESERVATION OF RIGHTS. HP and its suppliers reserve all rights not expressly granted to you
in this EULA.

(c) 2007 Hewlett-Packard Development Company, L.P.
Rev. 11/06
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HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.

Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Customer support

Get telephone support, free during your warranty period, for ~ Country/region phone numbers are on the flyer that was in the
your country/region box with your product or at www.hp.com/support/.

Have the product name, serial number, date of purchase, and
problem description ready.

Get 24-hour Internet support www.hp.com/support/licp5220series

Get support for products used with a Macintosh computer www.hp.com/go/macosx

Download software utilities, drivers, and electronic information www.hp.com/go/ljicp5220series_software

Order additional HP service or maintenance agreements www.hp.com/go/carepack

Repack the product

If your product needs to be moved or shipped to another location, perform the following procedure to
repack it.

/A CAUTION: Shipping damage as a result of inadequate packing is the customer's responsibility. The
product must remain upright during shipment.

/A CAUTION: Itis extremely important to remove the print cartridges before shipping the product. Print
cartridges left in the product during shipping will leak and entirely cover the product with toner.

To prevent damage to the print cartridges, avoid touching the rollers, and store them in the original
packing material or so that they are not exposed to light.

1. Remove all four print cartridges and ship separately.

B NOTE: Use the packing sleeves and protective covers from replacement cartridges to protect the
exposed print-cartridge drums.

2. Use the original shipping container and packing material, if possible. If you have already disposed
of the packing material, contact a local mailing service for information about repacking the product.
HP recommends insuring the equipment for shipment.
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Service information form

WHO IS RETURNING THE EQUIPMENT? Date:
Person to contact: Phone:
Alternate contact: Phone:
Return shipping address: Special shipping instructions:

WHAT ARE YOU SENDING?

Model name: Model number: Serial number:

Please attach any relevant printouts. Do NOT ship accessories (manuals, cleaning supplies, and so on) that are not required to complete
the repair.

HAVE YOU REMOVED THE PRINT CARTRIDGES?

You must remove them before shipping the printer, unless a mechanical problem prevents you from doing so.

[ 1Yes. [ 1No, | cannot remove them.

WHAT NEEDS TO BE DONE? (Attach a separate sheet if necessary.)

1. Describe the conditions of the failure. (What was the failure? What were you doing when the failure occurred? What software were you
running? Is the failure repeatable?)

2. If the failure is intermittent, how much time elapses between failures?

3. If the unit connected to any of the following, give the manufacturer and model number.

Personal computer: Modem: Network:

4. Additional comments:

HOW WILL YOU PAY FOR THE REPAIR?

[ 1Under warranty Purchase/received date:

(Attach proof of purchase or receiving document with original received date.)

[ 1 Maintenance contract number:

[ 1Purchase order number:

Except for contract and warranty service, a purchase order number and/or authorized signature must accompany any request for
service. If standard repair prices do not apply, a minimum purchase order is required. Standard repair prices can be obtained by contacting
an HP-authorized repair center.

Authorized signature: Phone:

Billing address: Special billing instructions:
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C Specifications

° Physical specifications

° Power consumption, electrical specifications, and acoustic emissions

° Environmental specifications
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Physical specifications

Table C-1 Physical specifications

Product Height Depth Width Weight

HP Color LaserJet 338 mm (13.3in) 588 mm (23.1in) 545 mm (21.5in) Without print

CP5220 Series Printer cartridges: 31.5 kg
(69.5 Ib)

With print cartridges:
40.9 kg (90.2 Ib)

Power consumption, electrical specifications, and
acoustic emissions

See www.hp.com/go/clicp5220 reqgulatory for current information.

Environmental specifications

Table C-2 Operating-environment specifications

Environment Recommended Allowed

Temperature 15° to 27°C (59° to 80.6°F) 10° to 30°C (50° to 86°F)
Humidity 20% to 60% relative humidity (RH) 10% to 80% RH

Altitude Not applicable 0 to 3048 m (0 to 10,000 ft)

B NOTE: These values are based on preliminary data. See www.hp.com/support/licp5220series for
current information.
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Regulatory information

° FCC regulations

° Environmental product stewardship program

° Declaration of conformity

e  Safety statements
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This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If this equipment is not installed and used in accordance with the instructions, it may
cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase separation between equipment and receiver.

Connect equipment to an outlet on a circuit different from that to which the receiver is located.
Consult your dealer or an experienced radio/TV technician.

74 Any changes or modifications to the printer that are not expressly approved by HP could void
the user’s authority to operate this equipment.

Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
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Environmental product stewardship program

Protecting the environment

Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production

Power

This product generates no appreciable ozone gas (Os).

consumption

Power usage drops significantly while in Ready and Sleep mode, which saves natural resources and
saves money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product, see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:

www.hp.com/go/energystar

Toner consumption

EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use

This product’s manual/optional automatic duplex feature (two-sided printing) and N-up printing (multiple
pages printed on one page) capability can reduce paper usage and the resulting demands on natural
resources.

Plastics

Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies

ey

ENWW

It's easy to return and recycle your HP LaserJet print cartridges after use—free of charge—with

HP Planet Partners. Multilingual program information and instructions are included in every new

HP LaserdJet print cartridge and supplies package. You help reduce the toll on the environment further
when you return multiple cartridges together rather than separately.

HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!

NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to www.hp.com/recycle.
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Return and recycling instructions

United States and Puerto Rico

The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.

Multiple returns (more than one cartridge)
1. Package each HP LaserJet print cartridge in its original box and bag.

2. Tape the boxes together using strapping or packaging tape. The package can weigh up to 31 kg
(70 Ib).

3. Use a single pre-paid shipping label.
OR

1. Use your own suitable box, or request a free bulk collection box from www.hp.com/recycle or
1-800-340-2445 (holds up to 31 kg (70 Ib) of HP LaserJet print cartridges).

2. Use a single pre-paid shipping label.

Single returns
1. Package the HP LaserJet print cartridge in its original bag and box.

2. Place the shipping label on the front of the box.

Shipping

For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit www.ups.com. If you are returning via USPS label, give the package
to a U.S. Postal Service carrier or drop off at a U.S. Postal Service Office. For more information, or to
order additional labels or boxes for bulk returns, visit www.hp.com/recycle or call 1-800-340-2445.
Requested UPS pickup will be charged normal pickup rates. Information subject to change without
notice.

Residents of Alaska and Hawaii

Do not use the UPS label. Call 1-800-340-2445 for information and instructions. The U.S. Postal Service
provides no-cost cartridge return transportation services under an arrangement with HP for Alaska and
Hawaii.

Non-U.S. returns

To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new product supply item) or visit www.hp.com/
recycle. Select your country/region for information on how to return your HP LaserJet printing supplies.

Material restrictions
This HP product does not contain added mercury.

This HP product does not contain a battery.
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Disposal of waste equipment by users in private households in the
European Union

This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Chemical substances

HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be found
at: www.hp.com/go/reach.

Material Safety Data Sheet (MSDS)

Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by accessing the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
community/environment/productinfo/safety.

For more information
To obtain information about these environmental topics:
e  Product environmental profile sheet for this and many related HP products
e  HP’s commitment to the environment
e HP’s environmental management system
e HP’s end-of-life product return and recycling program
e Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment.
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according to ISO/IEC 17050-1 and EN 17050-1; BOISB-0805-00-rel.1.0

Manufacturer’s Name: Hewlett-Packard Company
Manufacturer's Address: 11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares, that the product

Product Name: HP Color LaserJet CP5220 Series
Regulatory Model:? BOISB-0805-00
Including: CE860A — Optional 500-Sheet Input Tray
Product Options: All
Toner Cartridges: CET740A, CE741A, CE742A, CE743A
conforms to the following Product Specifications:
SAFETY: IEC 60950-1:2001 / EN60950-1: 2001 +A11

IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC: CISPR22:2005 / EN55022:2006 - Class B"
EN 61000-3-2:2006
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 2004/108/EEC and the Low Voltage Directive 2006/95/EC, and
carries the CE-Marking c € accordingly.

This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.

2) For regulatory purposes, these products are assigned a Regulatory model number. This number should not be confused with the product
name or the product number(s).

Boise, Idaho 83713, USA

January 2009
For Regulatory Topics Only:

European Contact Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard Gmbh, Department HQ-TRE / Standards
Europe, Herrenberger Strasse 140, D-71034 Boblingen, Germany, (FAX: +49-7031-14-3143),

USA Contact Product Regulations Manager, Hewlett-Packard Company, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, USA,
(Phone: 208-396-6000)
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Safety statements

Laser safety

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.

/A WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.

« Conforme a la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

VCCI statement (Japan)
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Power cord instructions

Make sure your power source is adequate for the product voltage rating. The voltage rating is on the
product label. The product uses either 100-127 Vac or 220-240 Vac and 50/60 Hz.

Connect the power cord between the product and a grounded AC outlet.

/A CAUTION: To prevent damage to the product, use only the power cord that is provided with the
product.

Power cord statement (Japan)

HEICIE, RSN =BRI—FZEHENTSL,
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EMC statement (Korea)
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Luokan 1 laserlaite
Klass 1 Laser Apparat

HP Color LaserJet Professional CP5220 Series, laserkirjoitin on kayttdjan kannalta turvallinen luokan
1 laserlaite. Normaalissa kaytdssa kirjoittimen suojakotelointi estaa lasersateen paasyn laitteen
ulkopuolelle. Laitteen turvallisuusluokka on maaritetty standardin EN 60825-1 (1994) mukaisesti.

VAROITUS !

Laitteen kayttdminen muulla kuin kayttdohjeessa mainitulla tavalla saattaa altistaa kayttajan
turvallisuusluokan 1 ylittavalle nakymattomalle lasersateilylle.

VARNING !

Om apparaten anvands pa annat satt an i bruksanvisning specificerats, kan anvandaren utsattas for
osynlig laserstralning, som éverskrider gransen for laserklass 1.

HUOLTO

HP Color LaserJet Professional CP5220 Series - kirjoittimen sisalla ei ole kayttajan huollettavissa olevia
kohteita. Laitteen saa avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkild. Tallaiseksi
huoltotoimenpiteeksi ei katsota variainekasetin vaihtamista, paperiradan puhdistusta tai muita kayttajan
kasikirjassa lueteltuja, kayttajan tehtavaksi tarkoitettuja yllapitotoimia, jotka voidaan suorittaa ilman
erikoistyokaluja.

VARO'!

Mikali kirjoittimen suojakotelo avataan, olet alttiina nakymattémallelasersateilylle laitteen ollessa
toiminnassa. Al katso sateeseen.

VARNING !

Om laserprinterns skyddsholje 6ppnas da apparaten ar i funktion, utsattas anvandaren fér osynlig
laserstralning. Betrakta ej stralen. Tiedot laitteessa kaytettavan laserdiodin sateilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
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Substances Table (China)

HEH BV RR
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<Color> in wrong position error
message 96

accessibility features 4
accessories

ordering 84, 128
acoustic specifications 138
advanced printing options

Windows 54
alerts

viewing with

HP ToolboxFX 67

Alerts tab, HP ToolboxFX 67
alerts, settingup 67
alternative letterhead mode 54
altitude specifications 138
anticounterfeit supplies 79
archive setting 9
auto continue

use 80
Automatic crossover

setting 36
automatic crossover, setting 9

background, gray 114
bands, troubleshooting 114
batteries included 142

bin, output
capacity 4
locating 5

black and white printing
troubleshooting 117

blank pages, troubleshooting 121

BOOTP 34

buttons, control panel 8

ENWW

cables

connecting network 29

connecting USB 29

USB, troubleshooting 121
calibrating color 12, 73, 113
Canadian DOC regulations 145
canceling a print job 50
cancelling a print job 50
capacity

output bin 4
cartridges

error messages 98

low or out, settings 13

non-HP 79

recycling 3

replace message 98

status, viewing with

HP ToolboxFX 67

storage 79

supplies status page 9

using when out of toner 80

warranty 80
cartridges, print

Macintosh status 28
characters, troubleshooting 115
cleaning 88

color
adjusting 58
calibrating 12, 73, 113

Edge Control 58

HP ImageREt 3600 62
Macintosh settings 28
managing 58

matching 60

Microsoft Office Basic Colors
palette 60

Neutral Grays 58

print in grayscale 58

printed vs. monitor 60
restricting 12
sRGB 59, 62
troubleshooting 112
color themes 58
color usage log 9
colored text
print as black 54
configuration page 9, 33
configure the product,
Macintosh 25
connecting
network 29
USB 29
contrast
print density 73
control panel
automatic crossover,
setting 36
language 9
lights and buttons 8
locating 5
menu map, printing 9
menus 9
messages, troubleshooting 68
Network Configuration
menu 9
network services, setting, IPv4,
IPv6 36
Reports menu 9
restore defaults, network
settings 37
restore defaults, product
settings 100
Service menu 9
settings 19, 24
show IP address, setting 36
System Setup menu 9
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copies, number of
Windows 54
counterfeit supplies 79
country/region of origin 6
cover pages 26, 51
creases, troubleshooting 116
crooked pages 116
curl, paper
settings 9
curled media 116
custom-size paper settings
Macintosh 26
customer support
online 135
service information form 136

declaration of conformity 144
default settings, restoring 9
demo page 9
density settings 73
device error message 96
DHCP 34
DIMMs
installing 84
verifying installation 88
disposal, end-of-life 142
documentation 128
dots per inch (dpi)
HP ImageREt 3600 62
specifications 4
dots, troubleshooting 113
double-sided printing 28
dpi (dots per inch)
HP ImageREt 3600 62
specifications 4
drivers
included 4
Macintosh settings 26
Macintosh,
troubleshooting 124
presets (Macintosh) 26
settings 19, 24, 25
shortcuts (Windows) 51
supported 18
universal 18
usage page 9
Windows, opening 51
duplex printing
Windows 44
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E-mail alerts tab,
HP ToolboxFX 69
e-mail alerts, settingup 67
Edge Control 58
electrical specifications 138
embedded Web server
accessing 21
Networking tab 78
Printtab 78
Status tab 77
Systemtab 78
end-of-life disposal 142
Energy Star compliance 4
engine, cleaning 88
environment specifications 138
environmental features 3
environmental stewardship
program 141
EPS files, troubleshooting 125
error messages, control panel 68
errors
software 122
European Union, waste
disposal 143
Eventlog 68
extended print modes
HP ToolboxFX settings 73

factory defaults, restoring 9

faded print 113

fan error message 95

features 4

Finnish laser safety
statement 146

firmware

about upgrades 89
first page

use different paper 26
fonts

DIMMs, installing 84
EPS files, troubleshooting 125
lists, printing 9

fraud hotline 79

front door, locating 5
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